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SUBSTANCE TIPS - JE=mr=s UNREAL ENGINE

Utilise Allegorithmic's Substance Painter to achieve post- Discover how to create incredible real-time environments and
apocalyptic style wear and tear on your triple-A game assets develop a distinct look and feel for your game art projects

GreatDigitalMags.com
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Buy your next PC from
a seven-time winner of

PC Pro’s “Best PC Brand”
award!

Fusion Projection 4
Professional 3D Editing Workstation

- Intel® Core™ i5-7600K "Kaby Lake" Processor
- NVIDIA Quadro M2000 4GB Graphics Card
- 120GB M.2 SSD / 1TB HDD

From £1599.99

= == For full specs please visit: www.chillblast.com/Projection4

Blazingly quick performance backed up by award winning
customer service and 5 year warranty.

Chillblast

www.chillblast.com/Projection
Call our sales team on 01202 057 275

Intel, the Intel Logo, Intel Inside, Intel Core, Core Inside are frademarks of Intel Corporation in the U.5. and/or other countries.
Price is comect at time of going to press (30-01-17) E&OE
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Epic Games®Robo Recall

Page 38

Welcome

ook close enough - and |

mean really look - and you'll

see fingerprints all over The
LEGO Batman Movie. Not figurative
fingerprints, real ones, placed
there by lead vendor Animal Logic
to heighten the sense of realism
and tangibility in the film. We
aren't watching animated digital
characters, we're watching animated digital versions of
plastic characters. This is, of course, reflected in
Animal Logic's incredible attention to detail -
fingerprints aside, individual bricks throughout the
LEGO Batman world are scuffed, dented and damaged
enough to look played with.

This month we've been lucky enough to go behind
the scenes at Animal Logic to learn all about the team's
artistic approach to filmmaking, the proprietary
technology driving innovation and how crucial
interesting and accomplished cinematography is in
building an animated picture.

Naturally, the fun doesn't stop there. Elsewhere in
the issue we've got a print exclusive look at Gleb
Alexandrov and Aidy Burrows' Space VFX Elements
masterclass for Blender, expert users reveal the 14
advanced skills you need to master in ZBrush and Epic
Games chats to us about the upcoming Robo Recall, all
topped off by a bumper tutorial section. Enjoy!

Steve Holmes, Editor

Sign up, share your art and chat to other artists at www.3dartistonline.com

3dartist@imagine-publishing.co.uk ¥ @3DArtist (f) Facebook.com/3DArtistMagazine
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The Expert Panel

ANIMAL LOGIC

animallogic.com

Dive headfirst into our incredible cover
feature on p22, as the talented team at
Animal Logic takes us behind the scenes
of The LEGO Batman Movie, revealing
some incredible stats in the process.
3DArtist username n/a

CLINTON CRUMPLER

clintoncrumpler.com

r Clinton creates some really fascinating
Unreal Engine environments in his spare
time (while he's not working on games
like Gears Of War 4). Jump to p58 to find
out how he does it.

3DArtist username ccrumpler

RAINER DUDA

rd-innovations.de

" Versatile technical artist Rainer has
branched out from Houdini and Clarisse
- - to talk a little bit about KATANA this

month. Check out his intro to lighting,
look dev and materials on p78.
3DArtist username Rainerd

M-

L=

AIDY BURROWS & GLEB ALEXANDROV

creativeshrimp.com/spacevfx.html

planets and galaxies over on p32. Learn
to model and texture planets, create
close-ups and go procedural.

3DArtist username n/a

MIDGE SINNAEVE
themantissa.net

y B@  Correctly compositing an image using
render passes is a really valuable skill.
i Over on p66, Midge is on hand to show
you how to do this properly in Blender's
Cycles renderer and After Effects.
3DArtist username Mantissa

PAUL CHAMPION
linkedin.com/in/pchampion
“ Over on p84, VFX trainer and

features include 32 new Light Sources
and more.
3DArtist username Rocker

Two veritable Blender geniuses combine
to walk you through creating astonishing

demonstrator Paul has put version 5.4 of
HDR Light Studio through its paces. New

This issue's team of pro artists...

PABLO MUNOZ GOMEZ
zbrushguides.com/work

Pablo returns to 3D Artist with another
spectacular sculpt this month, this time
featuring a stripped back ZBrush-to-
Photoshop workflow that shows off his
admirable hair and fur skills.

3DArtist username pablander

LEONARDO IEZZI
leonano.com
— & A veteran of Sony London Studio and
t Ubisoft Reflections, Leonardo is a brilliant
games artist. Head over to p74 to learn
how to save time while texturing your
game assets in Substance Painter.
3DArtist username leonano

ORESTIS BASTOUNIS
twitter.com/mrbastounis

Escape Technology very kindly provided
Orestis with an HP workstation to test the
new NVIDIA Quadro P5000, part of the
new line of Pascal GPUs. You'll find his
review over on p82.

3DArtist username n/a
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Blackmagicc'

DAVINCI RESOLVE 12

The world’s best color corrector is now the world’s best editor!

DaVinci Resolve 12.5 is the only professional editing and color correction software
designed to work with virtually all video and DSLR cameras! Developed in
partnership with Hollywood, DaVinci Resolve lets you edit, color correct, add
effectsand delivervideo from start to finish at the highest digital film quality. That
means you can create and finish better looking projects, faster than ever beforel

Professional Editing
Edit faster than ever with a professional multitrack timeline and easy to learn
tools! DaVinci Resolve 12.5 features media optimization for incredible
performance, along with editing, trimming and automatic color correction tools
that helpyouwork fast! You also get audio mixing, title tools, export presets for
You Tube, Vimeo and morel

Dramatically Better Color

DaVinci Resolve 12.5 gives you far better color tools than any other editing
system! They'rethe sametools Hollywood colorists use every day on blockbuster
films and television shows! With DaVinci Resolve 12.5, you can guickly create,
load, modify and save amazing looks that can be re-used across all of your
projects with a single click!

Incredible Effects

DaVinci Resolve 12.5 features ResolveFX, an amazing collection of high
performance plug-ins such as blurs, light rays, mosaics, and more! You also get
transitions, title generators, keyframe animation, speed ramp effectsand Fusion
Connect, which lets you link and send shots to Fusion for visual effects!

Download for Free

With DaVinci Resolve 12.5, you don’t need a monthly subscription or a
connection to the cloud because it's absolutely free! You get everything you
need to edit, colorand deliver SD, HD and Ultra HD projects. Whenyou're ready
to go beyond Ultra HD, work in 3D, or with multiple users, you can upgrade to
DaVinci Resolve 12.5 Studiol

DAVINCI RESOLVE 12

Free Download now, for Mac OS X and Windows.

www.blackmagicdesign.com/uk
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News, reviews
& features

12 The Gallery
A hand-picked collection of incredible
artwork to inspire you
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22 Heroes of Animation
We go behind the bricks with Animal
Logic's animation team on The LEGO
Batman Movie

32 To Infinity and Beyond
Blender experts Gleb Alexandrov and
Aidy Burrows reveal all about how to
make interstellar planets, galaxies and
more in the free software

38 Unreal Fidelity: Robo Recall
Epic Games tells all about the challenges
in making its first fully VR game in only

ten months &6 Part of the brief on

LEGO Batman was to
make it seem like it
was filmed with real

miniature brick sets py

Craig Welsh from Animal Logic
reveals all Page 22
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44 14 Advanced ZBrush skills
The world's best ZBrush minds give us
the lowdown on techniques for creating
bigger and better sculpts

77 Technique Focus: Nuremburg
Bathroom
Mohammadreza Mohseni tells how he
uses real-life lighting references to
determine the intensity for his arch-
vis scene

80 Subscribe Today!
Save money and never miss an issue by
snapping up a subscription

82 Review: PNY NVIDIA Quadro P5000
Is this new Pascal-powered GPU worth
upgrading to?

84 Review: HDR Light Studio 5.4
Paul Champion puts the new version of s
the all-in-one lighting solution to the test - e — e
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98 Technique Focus: Cake Please
How Peter Ang utilised a Corona light
rectangle and fill light to create this
mouthwatering food render

Light a cinematic
scene in Unreal

o
Enhance your

workflow s
KATANA .

page 80
SUBSCRIBE TODAY | for details




Unreal Fldellty* ¢
35 Robo Recall

The Pipeline

50 Step By Step: Master hair & fur

in ZBrush

Pablo Mufioz Gémez tames
FiberMesh and ZBrush to create an
aggressive wolf

58 Step By Step: Light a cinematic

scene in Unreal
UV MaSter has d Learn how to add atmosphere to
Slmp|e and €asy your real-time environments
interface that 66 Step By Step: Composite Cycles
guesses properties render passes in After Effects
and lets you see the Get to grips with multi-pass
unfolding 01: a mesh compositing in Cycles
in real time 74 Pipeline Techniques: Build

post-apocalyptic textures
for games

Explore production-proven
processes for quickly texturing
details with Leonardo lezzi

Pasquale Giacobelli reveals
advanced ZBrush techniques
Page 44

78 Pipeline Techniques: Enhance
your workflow with KATANA
Discover how to use Alembic
processes and manage asset
behaviour for a better workflow

To Infinity and Beyond P [

88 Community News
New live-streaming channel
ZBrushLIVE launches to bring
regular Pixologic content, streamed
directly to you via Twitch

90 Industry News
The Unity and OctaneRender
integration gets more Light Map
features, and Chaos Group is
awarded an Oscar

Bu d post—apocalyptlc 92 Project Focus: A Monster Calls
, textures for games MPC's Ferran Domenech reveals all

about raising a monster from the
ground up and how emotion was
Visit the 3D Artist online shop at created from its wooden surface

|mag|neShop co.uk 96 Readers' gallery

for back issues, books and merchandise The very best images of the month
from www.3dartistonline.com

£



Free with
your magazine

Ins| dible free gifts...

UE4 video tuiton ~ PSD-Manager 25 textures from Plus, all of this

from Pluralsight exclusive trial 3DTotal.com Is yours too...
Create incredible Unlimited use and no Download plenty of . Project files and hi-res screens o

materials for vehicles watermarks until March!  high-quality textures accompany our Unreal Engine 4

environments masterclass

+ Loads of quality content from our still
life tutorial, including Blender files,
After Effects files, an EXR image and
hi-res screens

+ Cycles and After Effects compositing

psd manager

»next level PSD/EgB export for 3ds Max

~deep data mask.generator 9 L & 3 g .
-render.elements output y : ik g A video gmde

~adjustment layers for gamma & color correction L =) { RS = . Mountains of screenshots to guide

-3DArtist special: free for you until end of March

' St B8 you through our expert tutorials

|||» Log in to www filesilo.co.uk/3DArtist -y

)  too!
r tablet,
on your

Register to get instant access
to this pack of must-have
creative resources, how-to
videos and tutorial assets
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FileSilo

The home of great
downloads — exclusive to
your favourite magazines
from Future!

" Secure and safe online
& access, from anywhere

) Free access for every
& reader, print and digital

" Download only the files
& you want, when you want

"\ All your gifts, from all your
;Jj issues, in one place

Get started

Everything you need to
know about accessing
your FileSilo account

Register

O Follow the instructions
on screento create an
account with our secure FileSilo
system. Log in and unlock the
issue by answering a simple
question about the magazine.

O You can access FileSilo
on any computer, tablet
or smartphone device using any
popular browser. However, we
recommend that you use a
computer to download content,
as you may not be able to
download files to other devices.

O If you have any
problems with

accessing content on FileSilo
take a look at the FAQs online
or email our team at the
address below

filesilohelp @imagine-publishing.co.uk

An Incredible
for subscribe

Subscribe today & unlock the free
gifts from more than 30 issues

Access our entire library of resources with a money saving
subscription to the magazine — that’s more than 400 free resources

Over 50 hours More than Hundreds of
of video guides 1,000 textures 3D models
The very best Brought to you by Vehicles, foliage,
walkthroughs around quality vendors furniture... it's all there

Head to page 80 to subscribe now
@Alreadyaprint subscriber? More than

Here’s how to unlock FileSilo today... +

Unlock the entire 3D Artist FileSilo library with your unique Web 5 O 0 reasons gged

ID —the eight-digit alphanumeric code that is printed above

your address details on the mailing label of your subscription to s u b sc r i b e vng

copies. It can also be found on any renewal letters.

e




The Gallery
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66 | wanted to do an
arch-vis image that had a
cinematic feel, so |
decided to place a subtle
silhouette of the main
character (building)
behind a foggy street.
The road textures were
painted non-procedurally
to control car light
reflections on the
puddles. Water droplets
on the window were
made with a simple
displacement map p9

Wai Kin Lam,
Melancholy Sanctuary IV, 2016

Wai Kin Lam
www.makonimation.com

Wai Kin is an arch-vis artist
who is now part of the Foster +
Partners visualisation team

Software 3ds Max, V-Ray,
NUKE, Photoshop

Workin progress...

| &
Have an image you feel passionate about? Get your artwork featured in these pages

Create your gallery today at www.3dartistonline.com




13



@
Akin Adekile
akin_adekile.artstation.com

Akin is a 3D modeller and
texture artist currently
working in the film industry

Software Maya, ZBrush,
Substance Painter, V-Ray

Workin progress...




Jesiis F Calderdn
www.jesusfc.net

Jesus is a multidisciplinary
artist, mostly focused on
grooming and environments

Software Maya, Quixel
Megascans, Redshift

.

as borne from a little
mouse that | bought one year ago for my
two-year-old son - it is a toy that came with a
book and the mouse's name is Timoteo. He
loved it for months, and now each time my
son sees a mou calls it that p9

ernandez Calderon,
Timothy the Autumn Mouse, 2017

Work in progress...

»
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66 This project was
realised in a day with a
picture reference. My
main objective during
this production was
simply practicing to
understand parameters
of the new RenderMan
21 shader, but also to
create realistic props in
a short time p®

Agathe Girard, =
Cup of Tea,%‘:é ;
Ll

Agathe Girard

www.agathe-girard.com

Agathe is a 3D artist currently
earning a BA in 3D Conception
& VFX at Aries school in France

Software Maya, ZBrush,
Substance Painter, RenderMan

Work in progress...



Zacﬁarias Réinhardt

zachariasreinhardt.com

Zacharias is a freelance 3D
artist and a Blender
Foundation Certified Trainer

Software Blender,
Photoshop

Work in progress...

6 | created this rendering during
SculptJanuary 2017. The topic was
“Turtle'. | found this great artwork by
Sergey Vasnev and thought | give it a
try. It was fully sculpted inside
Blender, | only used procedural
textures for the materials and
rendered it in Cycles g9

Zacharias Reinhardt,
Turtle, 2017
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Max Emski

maxemski.com
Initially working in

il  Scene | was trying to
Software Maya, Arnold |mag|ne hOW d
Renderer manufacturer of droids
o8 might look. | wanted to
create something close
to reality. | really like
Kuka's robotic arm
design, so | decided to
put it into my scene B9

Max Emski,
Robotic Arms, 2016







The Gallery . In depth

6 \\Vhen | created one of them | decided to rotate it
180 degrees. | liked how it looked and this idea
inspired me to make the full scene, where some
robots were manufacturing others g

Max Emski,
Robotic Arms, 2016

MODELLING

RIGHT The first part of my
process was designing the
main part of the arm. At this
stage | used subdivision
surface modelling. | think that
good wireframing is important
for a shape like this.

FURTHER DETAILS

RIGHT In the second stage |
created a more detailed droid
inspired by the film Elysium. |
didn't model anything that you
can't see in the scene.

20
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SURFACE DETAILS
ABOVE For the third stage |
made pipes, wires and
more, and duplicated all the
meshes to add to the
scene's complexity. For
pipes | used Displacement
maps for adding surface
detail. For smaller details |
didn't use any subdivision.

ADDING TO THE SCENE
LEFT During the final stage |
made a simple environment,
along with props and a
conveyor. That conveyor is
central to the scene, so | puta
lot of focus on it.
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2016 WARNER BROS.
ENTERTAINMENT INC.
AND RATPAC-DUNE
ENTERTAINMENT LLC.
Photo Credits: Courtesy
of Warner Bros. Pictures

o

W G ©f O @ Of @F &

o

9

NS B

D NS NS BN

W R0 B B BN
SNy )
) Y Y
I S B B
@ B B B B



-t ! ! -

- f ~f o o o o o o f f f f f f f o &
<« ¢ ¢ I .~y
< o I -
@
e - X ~—t ' ~t - _— - ~r ~—r ~t ~t -
hen Animal Logic completed work on
~ 4 The LEGO Batman Movie, the latest
) ) j instalment in its animated LEGO

adventures, its artists worked out that the entire
film would take 57,418,857 hours to render, albeit
on a single CPU. Of course, the animation studio,
which now has offices in both Sydney and
Vancouver, relies on an advanced render farm to
complete its 3D animated features and visual

8 effects work.

And for The LEGO Batman Movie, that work was
incredibly complex. A crew nearing 500 people
laboured over 451 CG characters in the film, along
with multiple vehicles, buildings and
environments, each effectively made up
collections of individual LEGO-approved bricks.

- o o o f f

- o o f o f

HEROES OF
ANIMATI

_ Key Animal Logic CG and design crew members reveal
"\ the pro VFX secrets behind The LEGO Batman Movie

Gotham City, for example, consisted of
220,831,071 bricks (in real LEGO brick terms, the
city would cover 379,095 square feet or 6.6
football fields in area).

Indeed, since The LEGO Movie was released in
2014, Animal Logic has ramped up both its
creative and technical prowess to become a major
player in animated features, while also keeping a
hand in visual effects.

To find out just what technical advancements
Animal Logic has made in its animation and VFX
pipeline, and how it brought a whole new level of
artistry to The LEGO Batman Movie, 3D Artist sat
down with key members of design, CG and
lighting teams to discuss the making of the film,
brick by brick.
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DESIGN FOR THE DARKNESS

The LEGO Movie, directed by Phil Lord and
Christopher Miller, was a major hit, tapping into
the much-loved stop-motion ‘brick films'. To
bring that style to life, Animal Logic had invested
significantly in a style of animation, virtual
cinematography and rendering technology that
resulted in a completely believable photoreal
look for the CG film.

It was something the studio continued to
advance on The LEGO Batman Movie, directed by
Chris McKay, who was the animation director on
the original film. This time, however, Animal
Logic had the opportunity to tap into much
darker source material: Batman.

“We wanted to explore what makes Batman
or Bruce Wayne (Will Arnett) so dark and
brooding, and how is it that a man that
essentially has everything, is famous, has
super-fast cars, lives in a mansion, and can hang
out with supermodels all day, why is he
fundamentally unhappy,” outlines production
designer Grant Freckleton.

And so began many months of research into
Batman-related material, from comic books to
animated films and television shows,
videogames and the various Batman feature
films. The studio worked closely with several key
stakeholders in the franchise, too, including
Warner Bros. Pictures, Warner Animation
Group, LEGO System A/S and DC
Entertainment. The collaborations would be
translated into almost countless collections of
character, vehicle and environment designs,
colour scripts and concepts by Animal Logic's
design department.

The design process was even more expansive,
perhaps, since The LEGO Batman Movie takes
place in a much larger world than the first film.
Freckleton actually looked to real LEGO
reference for how that expansiveness would
work in this film.

“If you go to LEGOLAND in San Diego or in
Denmark they build these city structures that
are amazingly detailed,” he says. “When you
step back or photograph them from far away
they look like real cities. They look completely
convincing. And we thought, well, why don't we
try an experiment with this idea and rather than
trying to make everything feel small and bricky,
how big can we make stuff out of LEGO bricks?
How much can we make this feel like a world of
infinite scope and infinite possibilities? As an
audience member, when you see Gotham City,
you care about the city. It's not like a toy set, it's
actually a real, living, breathing place.”

To realise that detail, Freckleton oversaw a
team working in mediums all the way from pen
and paper to Photoshop and, more and more, in
3D modelling, even just for designs. “Even
though we may do a drawn environment first,
he says, “we'll also follow through in the art

"
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Look closely at the Minifigure
characters in the film and
you'll soon spot wear and tear
and other inconsistencies in
the plastic that make them
feel real, not digital
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Batman's Bat
Grapple Gun
was the most
used CG prop
in the film,
appearing
442 times

66 Ve wanted to
explore what makes
Batman or Bruce
Wayne so dark
and brooding gw

Grant Freckleton,
Production designer
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department with nutting out the spatial
relationships of the larger-scale sets. And that
means artists will be working in Maya and also
LEGO'’s own design tool and building models to
use that way.”

ART AND SCIENCE OF BRICKS

The enormous world of The LEGO Batman Movie
revolves very much around a brick look and feel.
This meant Animal Logic's pipeline had to
handle some impressive brick building - in fact,
a total of 3,180 bricks were part of Animal
Logic's brick library, up from 2,000 on the first
film. And, like the original, the studio started by
modelling bricks in LEGO's freely available LEGO
Digital Designer (LDD) tool. This meant the film
assets would accurately reflect the toy
company's official set of available bricks.

Out of the LEGO Digital Designer, Animal
Logic took the LXS files and brought them into
their own brick pipeline set of tools. “We've
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dubbed those tools a ‘shell bake'," explains CG
supervisor, Damien Gray. “Here we basically
take that LDD description and we feed that to a
tool that would then retrieve the geometry from
the actual brick database that we had built. We
actually revisited a lot of our more common
bricks and tweaked and scrutinised some of the
topology and some of the roundness of creases
and edges there.”

The next stage involved the assembly of this
data into a physical 3D model that could be
loaded into Maya. Here, any redundant details in
the model like internal components in the bricks
are stripped away for better efficiency. A jitter
algorithm also enabled the bricks to be slightly
pulled apart and rotated so that they did not
look too uniform. The result was small gaps just
like you'd see in real LEGO creations.

Similarly, the textures of the bricks and final
models themselves were crafted to reflect real
plastic, right down to the little imperfections.

Animal Logic's proprietary
physically-based renderer,
Glimpse, was improved upon
for the film to deal with the
plastic characters, vehicles
and environments

217 different
Bat models
were made
for the film

“We ended up generating 81,854 textures,”
notes Gray. “A lot of those are Decal maps, but
there are Displacement maps and also Scratch
maps and Dirt maps.”

Even human fingerprints became part of the
finest details on some of the models, as Gray
explains. “We added fingerprints selectively to
certain models. We can do that at a brick level,
so that those fingerprints could be propagated,
and then we'd also create multiple variations of
fingerprints per brick so they could be
procedurally spread across a model. We also
selectively applied fingerprints on a model once
it had been assembled.”

What made Animal Logic's VFX and
animation pipeline even more powerful was the
development of a system that allowed artists to
access individual bricks at any stage in the
pipeline. This provided ‘per-brick control’, and
gave the studio a flexible approach to
manipulating models and textures.

MODELLING A
SUPERHERO
MINIFIG

The characters of The LEGO Batman Movie
received some fresh upgrades for the film

Like they were in The LEGO Movie, minfigures
(or minifigs) are the main characters in The
LEGO Batman Movie. Batman, Batgirl, The
Joker, Robin and scores of other characters fill
the scenes, each modelled and animated by
the team at Animal Logic. The studio took the
opportunity to revisit its approach to the
minifigs from the original film, starting with a
reassessment of their dimensions.

"“On the first film we pretty much modelled
the minifig using photographs and our
eyeballs... but this time we actually went out
and did a 3D scan of a real minifig to get
those proportions accurate,” says CG
supervisor Damien Gray.

From that, a few extra details were
incorporated into the models of the minifigs,
such as the way the torso slightly overhangs
the hips when their legs and body are
connected together.

In addition, LEGO moulds were made for
the minifigs and often involved soft sculpts
that could be re-worked for specific details,
such as hair, and to achieve the right
silhouette for the character.

Animal Logic's final minifig models
represented the hours of work behind all
aspects of the characters, from face shapes to
colour and costume choices. A trademark of
the studio's final minifig models, and all the
models in the film, was the inclusion of
real-life textures; things that impact on actual
LEGO minfigs and bricks. “We generated
something we termed ‘grunge’, which would
actually put dirt and extra detail into the
corners and the cracks and the crevices of our
LEGO models,” notes Gray.

With 451 characters in the film, and with
many having multiple costumes and
accessories, a huge effort was required to
produce minifig models. The Robin model, for
instance, had 31 version iterations. That's a lot
of data, even for a superhero.




HEROES OF ANIMATION

'LEGO BATMAN
BY THE NUMBERS

A whole lot of crew, bricks and rendering hours
went into making The LEGO Batman Movie

N

13,486, 203

animating the film:

g Blggest LEGO
rcharacter Kraken 1 1 1 2 8 4 bricks <:|
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3,630,991 776 171
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Number of light rays simulated
by Glimpse renderer:

269, 559 350

brick textures:
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—> Largest LEGO vehicle: bricks
B-52 Batplane \

Biggest
LEGO building:
Wayne Manor
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98 BUILDING THE BATCAVE GARAGE
How Animal Logic designed, modelled, lit and rendered Batman's impressive

S  collection of vehicles inside the caped crusader's Batcave
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== A CONCEPT SKETCH OF THE BAT-VEHICLE ROTISSERIE

2) € The level of detail, even in the illustration, was designed to show how over-the-top Batman's
possessions in his Batcave were. It was based on initial storyboards. “From the storyboards,” outlines

WP production designer Grant Freckleton, “we essentially started breaking down what we saw in the reels

! or from the script and worked out what we needed to design.”
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THE 'SPICE RACK" MODEL
TAKES SHAPE

This portion of the Batcave represented just one
section of the voluminous environment. If built for
real, the Batcave would be constructed out of
50,999,853 LEGO bricks, and take up 3,996 square
feet. To help manage such enormous scenes,
Animal Logic worked out ways to deal with
repeating bricks. “For example,” says CG
supervisor Damien Gray, “when you build a brick
wall out of 2xIs, it's the same brick over and over
again, stacked. To make it easier, we'd create
different Scratch and Warp maps and
Displacements for those bricks, and we
randomised the reflection of those maps for that
brick when it's assembled into a single asset.”
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6 In animation we'd
always focused on
doing a silhouette,

but | said, let's break

with that ps

Craig Welsh,
Lighting supervisor

LIGHTING FOR LEGO

In computer graphics, almost any kind of final
look can be generated by an art team. But, just
as it did on The LEGO Movie, Animal Logic went
through a painstaking process of researching,
then lighting and rendering The LEGO Batman
Movie. Cinematography techniques borrowed
from the physical world were adopted, and
live-action films also referenced for their
specific looks that also satisfied the Batman and
comic book universes.

“Chris McKay said he wanted to go for a film
noir style with the sort of colour saturation one
might expect from some sort of hallucinogenic
acid trip,” outlines lighting supervisor Craig
Welsh, who studied many films in order to find
examples of what might work in particular
scenes or shots.

For example, in some of the scenes set inside

g ) | Wayne Manor, Batman is shown arriving home
y % seemingly to party after dispatching several
villains, but is actually shown to be living a
lonely bachelor’s life with no-one but Alfred for
company. At one point he seems lost in a
reminiscence from the moment he was

_ >
-
.u"""ﬂ * »

)

THE BATCAVE IS
BATHED IN BLUE

The final lighting and rendering of the Batcave
made use of around 22,000 lights, many of
which were made possible via a procedural
lighting rig. “We identified bricks that were of
interest to us to attach lights to,” says lighting
supervisor Craig Welsh. “They might be part of
practical light fittings or lights in vehicles sitting
around the Batcave. Then we made a miniature
light rig sitting at the origin of the scene that said
this light belongs to this brick, and it has these
parameters and does these things in terms of
shadow casting and ray tracing. And then all
those lights are propagated through the scene at
render time in our in-house renderer, Glimpse.”

tragically orphaned as a boy. Welsh wanted to
help communicate how he might be immersed
in that thought process, and turned to what
real-world cinematographers had done for
similar scenes.

“I had seen some films and TV shows by Cary
Fukunaga, who did Jane Eyre and True Detective,
and noticed that the director of photography
was not traditionally separating the characters
out from their backgrounds with rim lighting,
but instead kind of melding them into the
background,” observes Welsh. “I was thinking of
this as a psychological thing and | thought, it's
like the characters are melding into their
environment, and they're kind of psychologically
part of that environment and they almost can't
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escape from it. And there was a similar
approach by the cinematographers Hoyte van
Hoytema and Adam Arkapaw and Bradford
Young," continues Welsh. “So | pitched that to
Chris McKay. In animation we'd always focused
on doing a silhouette, but | said, let's break with
that. Let's not have a rim light while he's being
introspective and thinking about his family life
and how lonely he is. Let's have him melt into
the background. We'll still get separation so we
can still see his bat ears and all that kind of thing
with colour tones. Chris McKay loved it. | told
him about all those DOPs | had been looking at
and he was like, ‘holy crap, we have to do that".”

Equally as important, Welsh also looked to
many scenes shot by those cinematographers in
question, in order to find examples of how The
LEGO Batman Movie should look as if it was
filmed with real cameras.

"Part of the brief on The LEGO Batman Movie
was to make it seem like it was potentially
filmed with real miniature LEGO brick sets and
minifig characters,” highlights Welsh. “So we
thought, alright, if we were shooting it for real
with real lenses we'd have some lens distortion.
And then we had to debate about whether we
should make it look like we're using miniature
lipstick lenses or GoPros with their
characteristic fisheye distortion, or whether we
should lens it as though we were at human scale
in a LEGO world. We ended up going with the
second process because it's a more natural feel
for storytelling, and everyone understands the
language of camera at human scale.”

Animal Logic even went as far as sourcing
test data from actual Panavision C-series lenses
and building the distortion parameters into its

virtual cameras, which was later reflected in the
final renders. The studio also continued the
development of a ‘lens kit' that allowed artists to
add in additional aspects such as stray light,
flaring, dirty lenses and various other
aberrations that come with real photography.
The team also rendered depth of field for this
film; traditionally something that had been done
in compositing.

66 \\Ve also selectively
applied fingerprints on
a model once it had
been assembled gy

Damien Gray,
CG supervisor
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Much of this was also made possible thanks
to Animal Logic's proprietary path trace
renderer called Glimpse. It had begun
development on The LEGO Movie and been used,
alongside Pixar's proprietary RenderMan, for
just a few shots on that film. Now the physically-
based renderer has had a couple of years of
further enhancement, with Animal Logic
switching over to it completely for The LEGO
Batman Movie.

“On this film,” begins Gray, “we were able to
get Glimpse to perform better and better and
faster and faster and bring in some other
techniques to actually accelerate the rendering
time. This included de-noising tools, which
helped with Glimpse because it's a progressive
renderer. You can render an image very quickly
but that means the image can be very noisy, and
you get to a point of diminishing returns with
rendering to remove the noise. So rather than
actually rendering the perfect image, we would
pick our moment, stop the renderer and then
start to apply various de-noise techniques. We
would never have been able to finish the film
without it.”

Thankfully, the film was finished, and Animal
Logic's Sydney studio moved right onto its next
brick-themed animated feature, The LEGO
Ninjago Movie, due for release later this year. In
the meantime, The LEGO Movie Sequel is taking
shape in the Vancouver studio and is scheduled
for release in 2019.

On top of all that, the Sydney studio has
several features in either production or
development, offering a wealth of new
opportunities for Animal Logic to continue
to innovate.
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et |
2017 Academy Award winner

150+ films and counting!
Thanks to all the artists who've supported us on this journey.

— Vladimir ‘Vlado’ Koylazov
2017 Scientific & Engineering Award
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| In this excluswe guide, Blender masters GIeb Alexandrov and Aidy ;
Burrows explore the key principles behind building beautiful gaIaX|es in 3D L

hink about Star Wars, for a moment. What
T brings those unending space vistas to life

the most are the bright and bold planets
that inhabit them, expertly constructed by ILM
and the like to create a layer of believability and a
sense of scale to help you feel at home in a
strange galaxy (far, far away). These environments
were built digitally - in modern films, at least -
and although a big glowing orb floating lazily
against a starry backdrop doesn’t seem that tech
at first glance, achieving a photoreal result can be
tricky, and there's somethmg of a lack of tuition in
the field.

This proverbial black hole in space VFX
education spurred talented videogame veteran
Aidy Burrows and mad, caffeinated genius Gleb
Alexandrov into action. Their video course, ‘Space

VFX Elements - Creating the Galaxy In Blender,
has been developed to help you achieve
production-standard CG galaxies with ease. Their
enthusiasm for the subject is palpable.

“Anyone who has spent any time writing
‘hubble’ into Google Images knows what I'm
talking about - space is gorgeous,” begins
Burrows. “And then once you think about what
you're actually looking at? That's crazy! It's hard to
get a handle on it at all. And what a canvas it is for
telling a story, new worlds where you can set the
rules and reveal something about all of us by
contrast. About what's important and about
where we may be headed.”

Alexandrov echoes this excitement. “Literally,

just watch the Space X Falcon 9 landing,” he

chirps. “Or check the Hubble Space Telescope

photos‘of billions and billions of galaxies SW|rI|ng

around a supermassive black hole. Or maybe
listen to how the Curiosity drone sings Happy
Birthday, while exploring Mars for us. If it doesn't
move you, | don't know what does. Artists and
filmmakers, | think, see space as a cool
background for their dreams. Some of them are
just as geek as we are. Fortunately, today, it's
possible to realise even the geekiest of space
dreams using free software.”

In this print exclusive, two of the most well
known artists working in the Blender community
today present their invaluable insights into
creating the sorts of space environments that
wouldn't look out of place in something like Mass
Effect or even Star Wars. Sit back, fire up Blender
and go get exploring.

'

< FIND S
/ OUT MORE \
ABOUT
SPACE VFX
ELEMENTS AT
\ bit.ly/SpaceVFX ,
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MODELLING & v
TEXTURING

Do you remember the awe-inspiring
wormhole effect from Interstellar? It made
me us excited as a child. This warping effect
- from the moment we saw it, we wanted to
reproduce it in Blender. The Space VFX
course gave us this opportunity. Let's first
create a sphere. Some kind of environment
around this sphere is a must-have, too -
after all, the wormbhole is mostly about the
environment. Focus on creating a
360-degree starscape in the first place. The
core of the wormhole effect is a kind of
gravitational lensing. In a nutshell, it can be .
done using the refractive shader. But hereis  ~™*-

W HOW TO MIX
THE PLANET :
SURFACE MAPS

Often we just want to quickly test our

design ideas. We don't want to dive into

texture painting or anything time »
consuming. Try this technique: download
some real planet textures - let's take Mars, a crucial thing: we can shift the Index or

the Moon and lo (one of Jupiter's larger Refraction this way, so it increases on a -
moons). So now we have these three surface AI DY S AYS glancing angle. Be sure to plug the Layer &
maps. Let's mix two of them using the third Weight node (set to Facing) into the Index for =

as a mask. For example, let's mix Mars with Of Refraction socket. ._.y? .

the Moon using lo as a mix factor. u i - e &
Surprisingly, the result is a brand-new BREAK IT DOWN' , 5 ; . \ 3 F_ Cra
planet. You can pick the name!

Cthulhu be damned!
THE PLANET SHADER: LAYERS Force the unimaginable
monstrous enormity of
everything into bitesize o

manageable chunks. For -
planet texturing, that
could be broken down

: into making just controls _
for oceans, craters, rivers e
V¥ USE DISTANCE FADE e be \ v -
and city lights.
When you're flying through those mesh
planes scattered throughout an asteroid e
field, or that volumetric cheating array of //

W CONSIDER THE LENS

planes we need to fade them out as the
camera passes through, otherwise it can
break the illusion. This is where the Camera

The default focal length of the camera is

Data node comes in. It's really pretty simple. 35mm. That's a good starting point for a lot
We take the view Z depth and divide it by of scenes. A low focal length packs a lot into
4 the distance we want the fade to take, so a the image in a confined space, while a high
value of 2 will mean that by 2 units away it'll focal length gives us that zoomed-right-in
be fully visible. With a value of O when the look and compresses the depth in the shot.

That's the sort of shot we might expect
when we're peering into space. Plus, it helps
fit the edges of all of our planes into the
camera border.

camera is right on the plane it'll be invisible.

% o SEAS £
15mm Focal Length 70mm Focal Length

34



V¥ QUASARS
AND VOLUME
RENDERING

Quasars are the brightest objects in the
Universe and, we would say, the hardest to
render - especially their accretion disk (as
swirling multi-layered stuff should be).
Fortunately, Blender has an awesome
Volume Scattering shader. The density of
this shader can be driven by the Procedural
noise, and the noise can be distorted by the
spherical gradient. This step is crucial
because the spherical gradient will give a
circular motion to the accretion disk. That
said, we can complement a physically
correct Scattering shader with a fake effect.
For example, add a couple of transparent
planes with the stars and galaxies.

- )

LR

i

WV FAST
VOLUMETRIC
SLICES CHEAT

To create space dust and nebulae you'd
probably want to reach for the Volumetric
tools for that smoky/cloudy look. We could
do that, sure, but the simulation and
rendering times can be astronomical, too.
Sometimes we can get around all that by
just taking stacked slices of Procedural
noise. Just have it plugged into a Mix shader
mixing between Emission and Transparency.
Using an array of simple flat planes we can
use our 3D noise. So long as we keep the
camera facing those planes, the illusion
should hold up.

GLEB SAYS

“"WATCH HOLLYWOOD
& NASA VIDEOS"

Hollywood and NASA -
very different sources
but I'd recommend
absorbing it all. The
footage from the NASA
probes like Juno is
marvellous. Likewise, the
Star Trek end titles by
Andrew Kramer are pure
inspiration!

V¥ ASTEROID MODELLING

One way to model an asteroid is to do it
procedurally. That means to use the 3D
noise to shape the asteroid. And what's
even more awesome, this will allow you to
create dozens of variations for free - zero
time spent! In the end, it's a matter of
swapping the noises and watching the .\
outcome. In Blender, you can easily do this.

Add a Displacement modifier, then feed the

Procedural texture into it. Let it be the

Voronoi texture (which is famous for cutting

away parts of the object in a stone-like

fashion). Alternatively, you can use the new

Micropolygon Displacement feature of

Blender 2.78. This way you won't have to

bother about the crazy amount of polygons

needed for the detailed geometry - it will

calculate on the fly.

5 h

V¥ LOTS OF NOISE!

Nature is noisy, seemingly at every scale,
whether it's the noisy movement of the
tiniest pollen particles suspended in still
liquid to the noisy arrangement of stars in
the sky. To get natural results, then, we
should be noisy. Our thinking should be
noisy and we should be noisy in the way we
use our noise. We want some noise
informing where we want our transparency,
and we want some noise informing the
colours of the parts that are more opaque.
Wherever you can put some noise - go crazy
with it!

35
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The first way, as we found out, is to use the
seamless detail textures. Scale these
textures dramatically, and they will tile.
Then blend these tiled textures with the
original one. ‘Wait, what about repetition?
Won't it look noisy as hell after you repeat
the texture 20 times?', you might ask. That's
true. At such scale, repetition gets out of
control. Fortunately, we can manage it. Try
breaking this mixed texture into different
tonal range areas, namely the dark and the
light areas. Say you'd like to bring the details
to the dark areas. Stay within the low values
of the tonal range, and vice versa.

V¥ MICROPOLYGON
DISPLACEMENT

'Okay, but what if | place the camera really
close? Say, a few miles above the surface?’
Then the third way to increase the
resolution is to use Micropolygon
Displacement. This feature was recently
added to Blender 2.78. When we saw it, we
nearly spilled coffee on our pants. Now we
can generate the real geometry on the fly
and not burn our computers. That's how it
works. First you activate the Adaptive
Subdivision checkbox in the Subsurf
modifier, then you drive the Object
Displacement by the Material nodes. The
object gets subdivided based on its size in
pixels (and then displaced).

\

AIDY SAYS

“ATMOSPHERE AND THE
ARTIST'S DILEMMA"

Things can get pretty
scientific in space, like
atmospheric rayleigh
scattering in the
atmosphere. But as much
as it may pain me
choosing between
scientifically accurate
and artist fakery/friendly
techniques, | almost
always choose the latter.

GLEB SAYS

"ATMOSPHERE HELPS
TO SELL A 3D PLANET"

Atmosphere really helps
to sell a 3D planet, if your
planet is not a dead rock
- the low, thick, woolly
clouds; the high, mist-like
clouds; and my personal
favourite, the
atmospheric scattering
effect. Multi-layered
atmosphere is the
hallmark of a great

planet shot. .\/. | 2 4

GET READY FOR YOUR CLOSE-UP

)

V¥ DISTANCE-BASED
DETAILS

The second way is to reveal the details
dynamically. In the Blender node editor you
can sample the Z-depth of the camera. That
means we can change some properties
based on the distance between the camera
and the object. Perfect! We can use this to
fade the textures in or out. So you modelled
this awesome exoplanet. Now add the micro
details like craters, and hook it up to the
camera Z-depth. We call it the level-of-
details hack. For those of you who have a
background in game development, like Aidy,
this should sound familiar.

W CAMERA VIEW
CULLING

When we first tried zooming in to the
exoplanet surface and rendering, our
happiness was spoiled. We got an error that
claimed, “Not enough memory". Then we
knew we had to invent a way to hide the
geometry outside the camera view,
otherwise it consumed all of our video
memory - and wanted even more!
Micropolygon rendering is that hungry. We
ended up using the Mask modifier, driven by
the Vertex Weight Proximity modifier. It
allowed us to show (and therefore displace
and render) only what the camera sees. Say
hello to mountains and craters!




W PLANET RINGS

If we're only seeing the rings from afar we
can do away with the millions of individual
bits of rock and ice that make them up and
just use a texture instead. We'll need a wave
texture set to Rings (surprise, surprise!),
then we'll plug this into the Vector of a
Noise texture. Now we'll have some
randomised distribution but still in a ring
formation. Then increase the Contrast with
a simple colorRamp node and voila - we've
done the hardest part.

VW CONTROL PARTICLE
SIZE WITH TEXTURES

Here's a cool, almost hidden trick. We can
use a particle system to create a trail of
particle planes to form a comet trail. Ideally
we want the particles to get larger the
further they are to the end as if it's all
spreading out. We can scroll down and find
the Textures area. Hit the New button to
create a texture and then change this to a
Blend gradient image type. The coordinates
need to be set to Strand/Particle and the
influence to Size. Now you'll see that the
gradient controls the size from black
(minimum) to white (maximum).

Particles (Side on) - Larger towards tail end J

\

AIDY SAYS

GO FLEXIBLE WITH
PROCEDURAL"

The beauty of procedural
creation is that you can
customise to an infinite
degree. Want to control

the size of the
continents? Done. Want
to animate some clouds,
but want a little more
swirl? Done.

V¥ CHEAP CHEATS WITH
GLOW PLANES

Rather than not being able to see the effect
of a large glow until the end compositing
stage, it's good to add one in early on using
textures. All we need is a plane with a
gradient texture set to Sphere. Be sure to be
using Object Coordinates - that'll make sure
the circle radiates out from the origin at the
centre of the plane. To get a better falloff we
want a Math node set to Power - use a value
of at least 2, which is the standard quadratic
falloff light tends to exhibit in the real world.

L

"

GLEB SAYS

“PROCEDURAL NOISES
RESEMBLE SPACE
PHENOMENA"

Procedural noise is a
maths function, which
creates the intriguing

visual patterns. It's
fascinating how these
patterns can resemble
the real space
phenomena - a Jupiter
super storm, a spiral
galaxy, a nebula. Crazy!

VW BEYOND THE
COLORRAMP
(CURVES TO THE
RESCUE)

The colorRamp is super useful, but it can be
a little too simple sometimes. Luckily we can
get the same kind of results from an RGB
Curves node but with some extra controls
thrown in. Change the X values of the far left
and right points on the curve to replicate the
colorRamp. Now we've got a Factor slider, so
we can back off the effect if we want - very
handy! It's great when you want to
procedurally control those continent sizes.

( - I

on

37



UNREAL FIDELITY: ROBO RECALL

——
N
»




Weapons are faifly: =1
stylised but still
recognisable with
real-world toy and
fantasy weapons
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Epic Games has published its first VR game, but
what does it take to build for virtual reality from
scratch using evolving features in Unreal Engine?

hen Epic Games debuted its VR
shooter demo Bullet Train at Oculus
Connect 2 in September 2015, there

was a lot of excitement over where this VR
experience could take the videogames developer.
Boundless possibilities and speculation arose from
fans, though there was just the short demo
presented: could the demo push Epic Games to
publish a whole VR game, based on Bullet Train?
Could this mean an even more empowered Unreal
Engine with top-of-the-line VR features?

For a while there was no news at all, but little
did the fan community know that Epic had started
work silently on another project in April 2016.
Over the next ten months, five team members
beavered away in Cary, North Carolina, where
Epic is based, constantly going back and forth
between planting headsets over their heads and
tweaking assets on their computers. Finally, at
Oculus Connect 3 it was revealed that this project
was Robo Recall, the company's first virtual reality
game: a first-person shooter built for the Oculus
Touch controllers and available for free.

In Robo Recall, the player is a RoboReady
employee tasked with recalling unruly, defective
customer service robots by using a whole arsenal
of tools. Epic called Bullet Train “a spiritual
predecessor” to Robo Recall and it's evident how
different the demo is in its straightforward
gameplay. Compare this to Robo Recall, which is
designed to be an enjoyable, immersive real-world
environment with a distinct, vibrant design.

Its visual inspiration harks back to older games,
as Epic Games' art director Jerome Platteaux tells

3D Artist. “We wanted to do something that feels
good to go back in, something that is visually
colourful and the player feels happy to be in every
day. My response was old-school games like on
the Neo-Geo and even Super Mario, we used a lot
of primary colours like in Super Mario.”

Most noticeable of these influences are the
retro damage-dealing effects; messages like
'headshot’ flash up in a bright-red gradient when
the player shoots the robot's head with precision.
“[Those classic games] use these really cool
primary colours for different things like burning or
healing, those type of things, so it's a really
efficient visual language,” says Wyeth Johnson,
lead technical artist. “We kind of took that
approach as, ‘Okay, how do we communicate as
much as possible in a [small] number of frames?"”

It's a significant question to ask, with
unforgiving consequences, he says. “If we're not at
90fps, if you miss your performance target in a

Everything
we develop for

actually going
to be shared with the
community

Jerome Platteaux,
art director
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console it's a little bit annoying, if you miss it in
virtual reality, you're literally making someone
sick! There are real ramifications to making sure
that the player has the absolute best experience
they can. Unreal Engine 4 has been completely
rebuilt from the ground up for virtual reality.

“We switched to the forward renderer, and the
biggest thing that this gives us is visual clarity.
We've rethought rendering in VR from the ground
up to provide the sharpest, most crisp, colourful
image to the viewer... we're learning that that's
really something that the viewer responds to.”

Another aspect that needed rethinking in the
VR landscape was the effects. “We had to really
rethink how we present things so they look like
they have volume inside a VR headset,” says
Johnson. “Something that might have taken a few
minutes to create, like a smoke puff, now needs a
couple of weeks of R&D to get right so it's been a
really interesting experiment in presenting a
two-dimensional thing in three dimensions.”

During development time, Johnson would put
on the Oculus Rift headset once every hour or two
hours for testing and iterating. “When we started
this project we spent literally months trying things
that normally would have worked without fuss
and without any problem and went ‘nope that's
not right'. | feel like I'm back in school again! This
is my 16th year making games and | feel like it's
my first.” The back-and-forth iterations was an
important part of the process for the entire team,
though the time spent in the headset would differ
depending on the stage of production and the

FINE-TUNING FOR VR

66 \We've
rethought

B rendering in
' /R from the
ground up to provide
the sharpest, most
crisp, colourful image to

the viewer

Wyeth Johnson,
lead technical artist

asset that needed to be worked on. Real-world
objects would take less time to check than, say,
the lengthy limbs of a robot with stylistic
proportions. It's a diligent way of working, not
least compounded by the necessity to translate
proportions properly from monitor to VR. “We
feel like something feels good on the screen then
when you put on your headset and check again in
VR, there may be proportions that feel different or
are perceived very differently,” says Platteaux.
This was one of the biggest changes for senior
mechanical modeller Pete Hayes. Like the other
mechanical modellers at Epic, Hayes had been
using 3ds Max and MODO: the same set of tools
he'd been accustomed to for years during Robo
Recall's production. “The biggest difference is

Epic Games reveals how it optimised its game asset workflow for virtual reality

"The biggest technical roadblocks we have as
modellers is [that] Normal maps are less
effective in virtual reality,” begins Epic Games'
Pete Hayes, senior artist mechanical, “and that's
the very small details, so you have to make sure
you have enough geometry to support the
medium to large forms because you won't be
able to fake as much... The other hand is the
materials - we can't do super-complex materials
because drop calls are one of the biggest things
we need to limit.”

To ensure that detailed models would
translate in VR without breaking the immersion,
Hayes explains that the back-and-forth iteration
processes assisted in keeping the production
efficient without compromising on quality. “We
model very detailed prototype meshes and then
test them out in-game before we really spend
any serious time on high levels of details and
then proceed very cautiously towards that final
goal, especially as we're on such a short
development time. Once we spent that time to

do that super-high detail, it plugged in, we knew
what to expect and it looked good.”

“The other big thing is knowing your budget,”
says Jerome Platteaux, art director. “In VR we
are constantly optimising. Even a robot - we
know exactly the final budget for that robot, we
know this robot is not over 20,000 verts and it's
not going across more than two maps.”

This restriction with verts and the budget is a
slight departure from how games were
previously built for console. Yet Platteaux says
that the overall process is still the same, it's just
that now the restrictions apply in different areas.
“We think of the environment and architecture
based on restriction. ‘[So you think] okay, I'm
not going to create a forest, so I'm not going to
create something that has a lot of foliage just
because we cannot afford it in VR'. We need to
anticipate: here's my budget, what can | do with
that? | would say that it's like any other game -
we need to know what the budget is first and
then figure out what can work with that budget.”

taking stuff into the editor and utilising Unreal
Engine 4 to see what works and what doesn't
work in VR and crafting artistically towards that,”
he says. “It's similar in a lot of ways but different
always, visually, and always being in it, having the
headset on to triple-check things, to make sure
they feel right in VR versus looking right on the
screen... The biggest advice is just don't trust what
you see on the screen, you have to test it in VR
and make sure it's on track and feels good.”

One of the principal ideas during the game's
conception was to create a sense of comfortability
and return value for the player, so having the
robots as the antagonists was key as the cold
hard-surface models helped to avoid the guilt
associated with shooting more humanoid
characters. Disproportionate environments and
models can be jarring for VR experiences, too,
with every member echoing the same sentiment:
scale plays a pivotal role in immersion and VR.
"We paid attention to make sure the proportions
are correct and so that it's easier for the player to
evaluate where it is and how it feels in the
environment,” says Platteaux. “It's easier... for the
player to connect, especially in VR."

Virtual reality is also creating a new way of
gauging scale, says Ignacio Guajardo-Unanue,
senior artist generalist. “Previously, in other
games, the character in the game would be your
scale reference. In VR, you are the scale reference.
So if a door is too small, you definitely feel it so
scale has to be just right.”

Hayes, on the other hand, tells the duality of
scale, of its difficulty and how motivational it can
be: “The challenges of modelling for VR is actually
the same thing that's great about it. Because you
can see your models in a real-world scale at any
and all angles, you have to ensure every square
inch is perfect and detailed realistically to what
you would expect in the real world.

“So if | create a 20-foot-tall robot for a regular
videogame it's still going to look small on a screen.
Viewing that same robot in VR is a completely
different experience because you can get close to
it, look up and feel that it's 20-feet tall. Being able
to view and interact with them in a VR space
makes them feel more real and tangible.”

Mechanical details were placed around the
robots’ necks at the player's eye level and
environment props in the world would aid in being
a reminder of the scale too. Achieving these set
areas of flourishes, and creating a uniform style
while balancing the quality of assets against the
short development time, was critical. Hayes
explains, “We started with a lot of existing kitbash
mechanical objects that Mark [Van Haitsma,
senior mechanical modeller] had done. So within
those robots, we shared a lot of those little fine
details and pieces - even though every single
robot in the game is very unique they all maintain
the same sense of visual style like they all were
manufactured by the same company. So that gave
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us consistency visually but that also enabled us to
share a lot of the mechanical parts within them.
So that’s one of the ways we accelerated our
development time and even with that, we were
still working extremely hard to pull everything off,
but it definitely made it all easier.”

“One of the conversations we had early on was,
‘What is one of the most efficient type of assets
that we can build that looks really great in VR and
has a low production burden?’,” explains Johnson,
“So, when we thought about the style that you see
now in Robo Recall, of these large, clean, simple
robotic shapes with really focused small amounts
of detail only where they really matter - that was a
very calculated choice on our part because we
knew we could bring in an incredibly high-quality
bar to the efforts without needing to spend weeks
and weeks modelling them.”

Some environment props were outsourced to a
secondary team with instructions to create the
appropriate scale, colour and albedo. Johnson
says that this was a “tactical” decision, as it
enabled the team to focus on the stylised models:
“The really important things that were really the
heart and soul”. This step was crucial, as the team
was able to “maintain our quality bar without
killing ourselves on the production side”.

The use of Unreal Engine 4 and physically
based rendering was another major contributing
factor in quickening production, says Johnson.
“We now don't have to spend a ton of time
texturing because the assets just look real out of
the box if we get our pre-production steps right.”

Platteaux adds to the benefits of the engine's
VR features being free to use and download by
anybody. The VR editor was used to build Bullet
Train, while the normal editor was used to build

i Previously in
other games,
the character
FAv’ inthe game
would be your scale
reference. In VR, you are
the scale reference wy

Ignacio Guajardo-Unanue,
senior artist generalist

Robo Recall: “The good thing [is that] everything
we develop for Robo Recall is actually going to be
shared with the community. Every time there's a
new feature in the engine, we actually release that
in the next release. Every time we have a problem,
we try to solve it and everybody gets the result of
it, so that's a great thing."

It's clear how thrilled Epic is to work in virtual
reality, to rebuild Unreal Engine for VR and to ship
Robo Recall. The company's passion for enriching
developers with its product shines through when
asked about about a wishlist for Unreal and VR: “|
think when you talk about Unreal, efficiency is the
name of the game,” says Johnson. “We need to let
teams of really small, talented passionate
developers make incredible VR experiences with
as little effort as possible. Removing the technical
barriers, the things we're fighting now, our hope is
that the future teams won't have to fight with
them: the struggle with performance, struggle
with optimisations, struggles with fidelity, with
physically based rendering.”

<A big VR lesson for
the team was trying
e .
to respect how easily
aplayer cal b,
overwhelmed

EPIC EXPERIENCE

Epic Games explains what its version of
the VR buzzword ‘experience’ means

“We want to make you feel like a total
badass,” begins Jerome Platteaux. “The more
the players find creative ways to destroy
robots, the more points they earn. Robo Recall
offers satisfying gameplay and loads of
replayability. We want the game to be as
much fun to watch as it is to play. | cannot
wait to see YouTube videos of players
executing awesome combos.

"The environments are based on existing
buildings and streets in order to get the
proportions of our levels as close to reality as
possible. The more the environments feel
familiar and believable, the stronger the sense
of immersion is. | wanted the experience to
feel grounded, to help the player understand
his surroundings and evaluate the distances
of his enemies faster.”

Ignacio Guajardo-Unanue says, “Robo
Recall is a VR experience that tries to fully
immerse you with its many interactive
elements to get different results. You want to
grab bullets? You want to block bullets? You
want to shoot at bullets? You want to block
some, grab another, and throw it at an
enemy? You can do it! You want to grab an
enemy, tear its head off, throw his head at
another robot, shoot that robot mid-air, grab
him, and throw him at another robot? Do it!
There are many ways to deal with combat
and its flexibility allows you to be creative.

|
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SKILLS

Remodel the way you work in ZBrush and discover
how to start working with our advanced tips for
creating high-res realistic sculpts today

lot of us will use ZBrush for sculpting. We
Amay all know how to manipulate ZSpheres

to build up a creature mesh, combine
SubTools for a character model or how to push
and pull our sculpts with the Move brush, but
there are plenty of other features inside of the
much-loved tool that you should start using and
paying more attention to.

Take brushes for example. Have you ever
considered going the extra mile and adding more
finesse to your sculpts by creating your own
custom brush?

Or what about using Alphas? There are over 60
of these available inside of ZBrush for deforming
your surfaces, but creating your own Alphas can

make way for more detail on your sculpts and a
more elegant finished result.

You might have given FiberMesh a bit of a look
in and understood how to use it to create hair and
fur, but what about its sister tool, NanoMesh?
Have you thought about what kinds of fantastical
meshes can be populated and the inspirational
abstract art you could create just by manipulating
a few more parameters?

To find out exactly how to work with these
features, we gathered some of the best ZBrush
minds to tell us just how they make the most out
of the tool. So delve into these 14 essential
techniques for advanced users and learn how to
make ZBrush truly your own.



ZREMESHER FOR
1 RETOPOLOGY
Always use ZRemesher on a duplicate

of your sculpted mesh! This can act as a backup
and will let you re-project sculpting details. Also,
try to avoid small holes in your mesh.

You can run the ZRemesher again once a mesh
has already been ZRemeshed, as this will make
the topology cleaner. However, it might not follow
the original mesh in an accurate way, so after this
subdivide the new topology and re-project your
original mesh.

If you are using Symmetry and are unhappy
with the resulting topology, go to Undo and then
try ZRemesher's second symmetry method by
holding Opt/Alt when clicking ZRemesher.

There are a few ways of refining the result of
ZRemesher. One way is to use PolyPaint. In areas
where you want the topology to be denser, paint
the mesh in red, while in areas it needs to be less
dense paint it blue. You can also use the Smooth
brush in between to get a nice transition.

One trick | found to be very useful is to
Polygroup your mesh before using the ZRemesher.
This can help in different ways, as you can Freeze
Groups or Keep Groups.

If you do Freeze Groups, ZBrush will
retopologise each Polygroup independently,
keeping borders frozen and then welding the edge
vertices together along each Polygroup border.

If you use Keep Groups, ZBrush retains the
existing boundaries of each of the model's
Polygroups to reproduce those groups in the
retopologised model. | use Keep Groups quite a lot
as it can help get rid of spiralling in the topology.
Andrei Szasz

TEXTURES IN ZBRUSH
So | want to explain a really helpful
trick for adding realistic details to a

face using photoscans. For this trick you should
have a low-poly mesh with subdivision levels. |
don't add a lot of small details for my mesh by
hand, only base forms and shapes like big scars or
scratches, which can affect to the topology.

First, create UVs of your model. This is really
important. For the UV unwrapping you can use
ZPlugin UV Master. The second step is to use
Spotlight to project photoscan Displacement
maps to your mesh as a Polypaint (Diffuse map)
and loading this map in the displ.map slot in
ZBrush. Next, export the Polypaint texture with
Multimap Exporter and load this map to the Displ.
map slot in ZBrush. Now change the intensity in
the Displacement map menu and look at your skin
details. When you see your skin structure with the
Displacement map you can add any folds and
smoothing; anything you want but your skin
structure never will be smoothed. This will really
help us understand where we need to sculpt
details by hand, perhaps by adding more
interesting skin structure and combining Disp
maps and geometry. After that we should apply

our disp.map to our mesh. You can turn off the
disp.map and export a second Disp map with
folds and big details.

You now have two Disp maps (pores and folds,
for example) and this will give you more control
for rendering later. You can bake all the maps you
need with the Multimap Exporter. After that, draw
skin colour, a Transluency map and others the
same way with Polypaint, Spotlight and Export.
Artem Gansior

MATCAP MATERIALS
AND LIGHTING
Using MatCaps is a great way to

quickly visualise your model in both different
lighting conditions and materials. Changing
MatCap while sculpting can get you a fresh
perspective on your model.

MatCap is a type of material that is lighting
prebaked as a mirror ball texture applied as a
‘faked reflection’ onto the shading of your model.

First, create a new ZProject with the default
sphere. Load the Basic material in your Material
slot. Load textureO1 in the Texture slot. Choose
widthto1024, heightto512 and press Clone in the
Texture palette in order to create a smaller clone
of the texture. Open the Light palette and load the
new HDRI texture into the Environment texture
slot in the Background subpalette. | changed these
Material settings: Specular to 51, Noise to 0.1, Env.
Reflection to 80, Colorize Diffuse to 100, Colorize
Specular to 10, Reflection Fresnel to -1.4 and
Reflection Blur to 2.

Go to the Tool menu and select the MRGBZ
grabber tool. Press Switch in the popup menu.
Drag a rectangle over the ball in the viewport in
order to make a mirror ball texture of it.

Select the MatCap Gray material and replace
the mirror ball texture in the Material Texture 1
slot. Please note that you can create a MatCap
texture from any rendering application by setting
up a material and some lighting and render out a
mirror ball texture.

Daniel Bystedt
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PAINTING IN ZBRUSH
4 Polypainting in ZBrush is a great
way of getting some colours on
your sculpt. This is very useful when doing
concept work, since it's not UV dependent and
can easily be projected between different
geometries early on in the process. Usually |
colour my models simultaneously as I'm sculpting,
since colour changes how the model is perceived.
| always start by blocking in colour gradients
with a clone of the Standard brush set to affect
RGB only. If the character has thin skin, | put a
subtle yellowish hue around where the bone is
visible (cheekbones, forehead and so on). Eye
sockets tend to go towards darker values with a
blur/purple hue. When painting on thin meshes, it
can be useful to activate Backface Auto Mask in
Brush>Auto Masking. To create skin tone
variations, create a new layer and paint with a
clone of Standard brush, with Stroke set to Color
Spray and a Color Intensity Variance to 1and
using Alpha 08. When using layers it's helpful to
paint in high contrast and then lower the Opacity
value on the layer itself, since ZBrush does not
have additional blending modes on layers.

More skin variation can be added by loading a
concrete texture or similar into Spotlight
(Texture>Add To Spotlight) and project paint it
onto the model by painting on a new layer. You
can change the contrast of the image by using the
Contrast button. If the colour reaches black, those
pixels will be considered transparent by Spotlight.
Daniel Bystedt

CUSTOM CURVE BRUSH
| like to create custom brushes to
generate something that fits in my

workflow: it's a simple tool that can easily be
adjusted or modified. In this example I'll show you
how to create a hair brush. It's a simple but nice
curve brush that can be quickly corrected to your
own specifications.

Load up a simple box in ZBrush and extend the
sides with ZModeler a couple of times. The width
of your box will define how big your hair strain will
be later on. Make a few extractions and delete the
top and bottom part of the box. Now place your
box correctly on your canvas and press W to
make it all into one PolyGroup. Under the Brush
palette press Create Insert Mesh and create a new
Insert Mesh brush.

Open the Stroke palette and turn on Curve
mode, then go to the Curve Modifier tab, select
Size and flip the Curve Falloff horizontally. Now
adjust the modifiers one more time in the Brush
palette by selecting Weld Points and Stretch. Now
you have your own curve/hair brush.

When you create a couple of brushes you can
make some nice-looking hair. It takes a bit of
practice to apply them, but the results look great.
And don't forget to close up your geometry with
Modify Topology and choosing Close Holes.
Maarten Verhoeven

PROCEDURAL SURFACE

NOISE

| don't use Apply To Mesh to create
procedural surface noise. Use MaskByNoise and
sculpt the detail into your mesh. | use the
Standard brush with Drag Rectangle to pull out
large areas of detail at once. This gives you a lot
more control over how it is applied to your mesh
and makes it look less procedural. If you're having
a hard time seeing what you are doing with the
mask visible, press Cmd/Ctrl+H to hide the mask.

You don't have to get every bit of surface detail
by using one Alpha or NoiseMaker preset. Break
the surface detail up based on patterns or height
levels and use a few NoiseMakers, using Layers to
blend them together.

Play with all of the settings, combining the
NoisePlugs with Noise Curves to see the flexibility
and limitations of NoiseMaker. Save out your
NoiseMaker Presets. Create a library for re-use.

You can also save out your Noise Maker to an
Alpha if you would rather apply the detail at
different scales or orientations manually with a
brush. In the Alpha tab, you can set a texture size
and press Create From NoiseMaker.

If you're not getting what you want in Surface
Noise, you can import seamless Alphas created in
Substance Designer and use Surface Noise to tile
it across your mesh.

David Schultz

BPR RENDERING
The Best Preview Render (BPR) can
provide some quick, rendered

results in seconds, with easily tweakable colours
and materials. First, in the Light palette, move the
light and adjust the intensity as desired. For the
Material I'm using gw_max_blinn with main
colour set as light grey.

Switch on Perspective, then go to the Draw
palette, and set Angle of View to 70. Now set the
Width of the document size to 4,906 and turn on
AAHalf. Now in the Document palette, go to
ZAppLink Properties>Create views>Save
ZAppLink Views.

In the Render palette, go to the Render
Properties sub-palette and set Details to 3. Toggle
on AOcclusion and Shadows and go to the BPR
Shadow sub-palette. Increase the Ray Number to
500, increase Resolution to 6,000 and set the
Angle to 30. Next, go to the BPR AO sub-
palette and increase the Ray Number to 400, set
Resolution to 4,000, drop Blur to O and render.

In the BPR Renderpass sub-palette, export
Shadow, AO and Mask. Now, in the Render
Properties sub-palette toggle off both Shadows
and AOcclusion. Hit Render. In the BPR
Renderpass sub-palette, export new Shaded.

For Specular and Rim passes, go to Material>
Material Modifiers and set Ambient and Diffuse
to 0 and Specular to 6. Then go to Lights and set
Intensity to 10 and Ambient to 0. Go to BPR
Render Properties and check that Shadows and
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AO are off and render. Now create a few varied
Spec and Rim renders and save each one.
Tristan Schane

ALPHA CREATION

With this Alpha creation method,

we can add some details to our
sculpt using images. Alphas work great with the
DragRect stroke. Get a free-use image and open it
in Photoshop and Desaturate. Use a blurred mask
to select the area to use. Then save as Sand_
Skin_1. Open ZBrush. Set the Doc size to square
dimensions for the best results. In Tool, go to
Quick Pick>Plane 3D and Convert to Polymesh3D.
Then go to Tool>Geometry and toggle off SMT.
Increase the res to 4 million and go to Morph
Target>StoreM. Next, go to Alpha>Import>
Elephant_Skin_1. With the Mask brush active,
hold Cmd/Ctrl and go to Stroke>DragRect. Next,
go to Alpha, select Elephant_Skin_1 and drag the
mask onto the plane. Using the mask, sculpt on
the plane to refine the Alpha mesh using your own
favourite techniques. Save the project.

Turn off Perspective. Fill the doc with as much
of the Alpha sculpt as possible, then go to
Alpha>Transfer>GrabDoc. The new Alpha
appears in the Alpha window. Export and open in
Photoshop. Create a black-filled bottom layer.
Using Layer Mask, fade out the edges of the
imported ZBrush Alpha layer. Name it and save.
Go back to ZBrush and import the Alpha.

Tristan Schane

CLEAN ZMODELER MODELS

ZModeler gives me an incredible

amount of control when it comes to
creating clean edges that | would never achieve
from simply sculpting. Removing and creasing
edges in conjunction with QMesh has helped to
get clean, hard-surface designs that were based
off organic shapes. ZModeler is a great tool for
turning organic sculpts into hard-surface objects.
As long as you keep your topology clean,
ZMaodeler will really come in handy. | sculpt from
a sphere, using DynaMesh to block out the basic
shapes and then use ZRemesher to get clean
topology. | make sure my target polygon count is
fairly low because the fewer quads we have to
work with, the easier this process will be.

Once your mesh is in quads, ZModeler will do a
lot of the heavy lifting. We can remove edges (by
going to Insert Edge Loop, hovering over an edge
and holding Opt/Alt) to create large chamfers
that make certain areas look hard surface. A
combination of removing edges and creasing
certain edges to retain hard-surface continuity is
key for transforming sculpts. Be sure to check the
Dynamic Subdiv to see how well the shapes are
holding up. Use this in conjunction with the Move
brush and QMesh. It will give you a lot of freedom
for creating organically shaped hard-surface
panelling. Use Alphas to add even more detail.
Travis Davids
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SKIN AND
CLOTHING
DETAILS WITH
ALPHAS

Digital sculptor Marlon
R Nunez teaches us
how to create folds in
ZBrush with Alphas

LIKENESS SCULPTING

Here is where | spent most of the
time. First | created a relaxed face.
Working in layers is the best
approach to be able to work on
likeness and facial expressions later
on, as it's an easier way that you can
amplify or decrease the layer effect
over the base. Once you feel
confident enough, you can bake out
all the layers you have used.

MARVELOUS DESIGNER
+ ZBRUSH

Even if the main mesh is exported from
Marvelous, there is bunch of work still
needed to be done inside ZBrush.
ZRemesh the mesh from Marvelous
and then project all the details on top
of the new mesh. Once you are done,
it's time to move onto the memory
folds and details of the garment.
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USING
TEXTURINGXYZ
DISPLACEMENT MAPS
FOR HIGH FREQUENCY
DETAILS

Overall, it is better to use the maps
from www.texturing.xyz, as they
provide enough details and
complexity for most of the face
microporosity. Don't forget that
those maps are just a starting point
- it is always better to add more
porosity and details in a separated
layer in ZBrush.

MEMORY FOLDS

With the help of Alphas and the
Standard brush | created all folds
that tell the story of the coat. Itis
important to pay attention to this

step, as it's going to give extra details
later during the texture process,
especially if you use Substance
Painter. All this information is
gathered on the baked maps.



| really like the Displacement method

because you can quickly add details to
simple geometry and create amazing-looking 3D. |
mostly use this technique on concept designs with
super-short deadlines when | don't have time to
create really detailled models. For this exercise,
I'm using a simple sphere with no UVMARP yet.
Create the UVs by selecting ZPlugin>UV Master>
Unwrap. Creating UVs is mandatory, as it's really
useful to have the correct UV because the
Displacement map will follow your UV
coordinates and normals.

Once you've UVed your sphere, head to
Tool>Surface>Noise. We'll use this basic input to
import our Displacement map. Now switch from
3D to UV to tell ZBrush to follow your UV
coordinates (button on the top) and then click on
Alpha On/Off on the lower left windows and to
load your Displacement map.

Once your Displacement map is loaded, you
won't see anything at first - it's because you need
to set the Mix Basic Noise setting to 0 and if your
mesh is looking weird, invert Normal by pressing
the H button. You can now play with the Strength
settings to see your model getting details from the
Displacement map.

Just press OK and make a quick render using
BPR engine. You will now have a detailed render,
but if you turn the model around, it will still look
flat. To export it as a complete object with the
Displacement map affected (baking everything),
go to Geometry>Convert BPR to GEO and it'll
bake everything into the model.

Antoine Collignon

UV MASTER MAPS
1 2 The UV Master plugin is a great and
fast way to create an automatic pack
UV of all models. | consider it a great tool to

automate the creation of UV layouts for my
objects. The first step is to create a blockout of the

1 1 DISPLACEMENT MAPPING

face in 3ds Max. Then using the GoZ, the system
that creates a dialogue between ZBrush and 3ds
Max, | imported the geometry.

Before you split and carve the advanced details,
generate the UV coordinates of the 3D models
with UV Master. With it | can get the automatic
unwrap of my 3D models in a few clicks, defining
where to place the cutting points and organise the
UV layout of the mesh relatively quickly. UV
Master has a simple and easy interface that
guesses properties and lets you see the unfolding
of a mesh in real-time. You can also directly edit
the UV pack of geometry through conventional
instruments: move, rotate and scale.

With UV Master it is also possible to decide
whether to import the existing UV coordinates or
whether it is preferable to select edges where you
want to cut geometry directly. But one of the main
characteristics of the tool that makes it unique
compared to other UV management software is
that it allows you to do a colour painting to define
the geometry of the mesh areas that need to be
given greater importance in terms of exploiting
the used UV space in the layout.

Pasquale Giacobelli

FIBERMESH BEST PRACTICES
1 3 FiberMesh is one of those tools that

can be amazing - if used correctly - or
very frustrating if you don't know how to set it up.
Fortunately, there are a few very easy things you
can do to avoid hiccups when working with
FiberMesh in ZBrush.

Polygroup planning is very important and gives
you more control over FiberMesh, especially if you
generate large portions of fibres with different
overall lengths.

Once the FiberMesh is created, it will keep the
Polygroups of the underlying geometry that it was
created from. This is incredibly useful when
enabling the Mask By Polygroup switch on your
brushes, from the Modifiers subpalette. With this
initial setup and brush settings, you'll only affect
the Polygroup you touch first, with the selected
brush of your choice.

You can actually work with any of the ZBrush
brushes on FiberMesh. However, the Grooming
brushes provide a more specialised tool to handle
the generated FiberMesh. What's even more
useful is that you can alter those brushes to
change the way they work. There is a whole
subpalette, under the Brush Modifiers, dedicated
to fine-tuning brushes for FiberMesh.

Just be mindful that when you use something
like the Slice curve, the topology of the fibres will
change and they will start behaving just like any
other polymesh.

Since the FiberMesh is actually real geometry,
you can create a new layer before you start
grooming. Once you're finished, you can go back
and play with the Layer slider to reduce or
increase the effect.

Pablo Mufioz Gomez

NANOMESH
CLOTHING

Travis Davids teaches us to create abstract
garments with NanoMesh and ZModeler

O Quadrangulate garment Once you
have created your garment in
Marvelous Designer, it is important to keep the
Particle Distance high - 20 should be fine.
Quadrangulate the garment by going to
Edit>Context Menu>3D Garment>
Quadrangulate. Quads will be useful with
NanoMesh. Now export your garment.

Modify Topology

N - :

O Weld points It is important to Weld

Points before we decimate to prevent
the garment from breaking apart. Go to
Geometry>Maodify Topology and simply click
on Weld Points. Now go to ZPlugin>
Decimation Master>Pre-process Current>
Decimate Current. The lower the percentage
of the decimation the bigger the triangles.

¢ smootH

03 Use ZModeler to add detail To
get the triangles to stand out, go to
ZModeler and inset all polygons. Now go to
Extrude and select Polygon All and extrude on
the new Polygroup created. Extrude the
amount slightly and the triangles will be more
prominent. Smooth some of these triangles to
get interesting results.

O 4 Explore further ideas using
NanoMesh The reason for quads

earlier is going to be useful with NanoMesh.
Import your garment and only Weld Points.
Now use NanoMesh to distribute geometry on
all of the quads. | used a simple cube and
adjusted values to get abstract results that still
follow the form of the garment.
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Based on a 3D mesh and rendered in
passes for compositing, this striking
wolf defiantly stares down the viewer

ith each step of the following tutorial, we'll take a
W look at the various processes involved in the

creation of the Alpha wolf illustration. The
approach will be methodical and we'll try to sculpt the 3D
elements with the end goal in mind, to save time and
optimise resources.

The creation process will start with the understanding of a
few key points of the wolf's anatomy, so that we can
exaggerate them in order to make the illustration more
interesting. There are a few important elements in the
composition such as the pose, expression and camera
position. We'll try to keep these key elements in mind during
the sculpting and grooming stages, so that each part
contributes to the final image.

The majority of this tutorial will be done in ZBrush, but
we'll use Photoshop for compositing the various render
passes. FiberMesh is an essential feature for the creation of
the wolf's fur, so we'll spend some extra time during this
stage of the process in order to get it right.
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PABLO MUNOZ
GOMEZ
The Alphg, 2016

Software
ZBrush, Photoshop

Learn how to
= Create a base mesh

* Optimise fur with
mesh sculpting

« Experiment with retopology
and projection

= Use polygroup planning

= Use polypaint and texturing
= Create effective poses

= Create and groom fur

* Optimise fur for rendering

* Render and composite

Concept

The idea was to capture a
growling wolf with a defiant
posture. This meant creating a
scene that implicitly involved
the viewer and illustrating a
palpable moment of tension
where the next action could
be decisive.

DOWNLOADS

from filesilo.co.uk/3dartist

* Concept art
» Tutorial screenshots

O Identify the wolf's features For your references, try

to collect things that are informative but also inspiring.
A wolf's anatomy is almost identical to that of a dog, but after
some research you can start to see the little differences that
give wolves that stylised uniqueness. If you know the
differences between dogs and wolves, you can start your 3D
mesh with a generic model of a dog (like the Dog.ZTL tool that
comes with ZBrush) and tailor it to work as the base for the
sculpture of your wolf. As a warm up, you could take on the
challenge of sculpting a cartoonish version of the wolf. This is a
fantastic way to learn and recognise the main features of a wolf.
This exercise will build on strong elements that will help to
identify your creation as a wolf and not a dog.

O Prepare the first base mesh When playing with

proportions, there is a lot you can do without adding
more geometry. In the previous step, the cartoonish version of
the wolf has the same topology as the generic Dog.ZTL. It
resulted from moving and smoothing areas. Similarly, you can
create a precise base mesh that describes the volumes of your
wolf. You can gradually start subdividing the geometry later,
when more details are required. In this case, we are taking the
existing topology of the Dog.ZTL and using the Move brush
and Transpose line with masks to alter the proportions and
shape the model like a wolf. Don't worry too much about the
polygon distribution, as this isn't the final base mesh.

O Sketch over the base mesh As mentioned, you

could have started with a precise base mesh and
subdivided it as you need to add more details. However, in this
case we'll turn the current base into DynaMesh by enabling this
feature from the Geometry palette. You can tweak the
resolution slider to get more or fewer polygons to work with,
and hold the Ctrl key and click+drag anywhere in the canvas to
re-DynaMesh. With DynaMesh on, we can take the
ClayBuildup brush and add some marks to establish a few
anatomical anchor points. These will be helpful when sculpting
the expression and other parts of the wolf's body.

O The key for the hair We are still early in the

sculpting process but this is where the foundations
are laid. One of the most distinguishing aspects of wolves is the
fur, and the intricate variations in its length and colour. We are
going to fake these variations a bit, and sculpt some layers of
fur with only geometry. This is a simple way to optimise the
amount of fur for render time. You could insert a sphere and
shape it, or use the geometry brush to create some planes over
the model and then extrude them with ZModeler. In this case
we are going to append a sphere from the SubTool palette so
that each part of the ‘fur’ base mesh is a separate SubTool.

Del Other




O Refine the fur geometry layers These additional
SubTools, or pieces of geometry, are there to simulate
the volume of the fur. They will also serve as a rough platform
to groom the hair and pull it in a particular direction. A key
aspect of making the plates of geometry useful is to integrate
them with the main model, so that they follow a unified
direction, and to ensure that the transition between pieces is
not abrupt. A very cool trick is to use the SnakeHook brush, and
hold the ‘Alt" key while pulling an area. This will make the
geometry you are pulling follow the adjacent geometry.

O Sculpt the fur with geometry At this point, we

have a good foundation for the hair and the model is
beginning to look more like a wolf. We can now go further and
sculpt big chunks of fur in the geometry, like clumps of hair.
This will give us an interesting look when grooming. We can
make the fibres from FiberMesh grow perpendicular from the
normals of the polygon. So, when groomed, these fibres will
give us the effect of having more individual hairs under the
surface, as the indentation will seem fuller. You can use the
ClayBuildup and Smooth brushes to sculpt the chunks of hairs
on the SubTools. The SnakeHook brush will help you achieve
those long hairs transitioning between SubTools.

O Retopologise Once the sculpt is done, we're going

to create a cleaner topology and transfer the details.

We can approach the retopology process in a few ways for this

particular project:

* Leave all the current SubTools on and create a single mesh
for the entire model. We can split it up later and we'll end up
with a more fluid topology.

* Retopologise every single SubTool individually and have a bit
more control over each part.

* Manually retopologise the most important parts and use a
quick ZRemesher for everything else.

We'll go for the third option as this will end up being an
illustration and we won't need to animate the wolf.

O Use manual and automatic topology Go ahead

and append a ZSphere as a new SubTool and enable
‘Edit Topology' from the Topology sub-palette. It is also a good
idea to enable symmetry (‘X' on your keyboard) before you
start. This process might be lengthy and requires patience.
Start drawing points along the head of the model to create a
cleaner topology. For the rest of the body, we'll use the
ZRemesher under the Geometry sub-palette. You can play with
the ‘Target Polygons Count’ slider if you need to adjust the
number of polygons created in this process.

Sculpting from references

If you are trying to match a specific reference like an
expression that you really like, avoid sculpting with the
perspective on. And, if possible, find out the camera lens
that was used for the photo reference you liked so you
can roughly match the ‘Angle of view' in ZBrush (from

the Draw palette).

Also, if you are limited to working with just one
monitor, you can make a single collage image in
Photoshop and import it as an image plane into ZBrush.
This way you can have your references always on hand
as a background when sculpting.
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O Transfer details Now that we have a cleaner

topology, we can transfer the details we sketched on
our DynaMesh model into a subdivided version of the new
model. Subdivide the newly created topology a couple of times,
to have enough resolution to capture the details. Select the new
mesh, make sure the sketched model is visible and click on the
‘Project All" button under the SubTool palette. Once the details
are projected, you can spend a couple of minutes cleaning up
any imperfections resulting from this process and simply
turning off the visibility of the sketch mesh (it is a good idea to
keep a backup).

‘I Cut up the model Now we are going to split up the

model to work faster and more efficiently (this is very
important once we start working with the fur). Since we chose
to create a SubTool for the head alone, we already have it as a
separate piece. The rest of the body, however, is one single
piece. The head will be a fundamental part of the final
illustration, so grouping it, will give us much more control. It is
also helpful to keep the body separate from the legs and tail but
you can leave the rest of the body as a whole and polygroup the
other areas after. You can use the Lasso selection tool to hide
parts on of the model and use Ctrl+W to assign a polygroup. Or
use the ‘Split hidden’ button from the SubTool palette to create
anew SubTool.

'I Create UVs Before creating the UVs, we're going to

create some more polygroups around the face. The idea
is to create groups that allow you to quickly select certain
groups of hairs for easy grooming. We'll create polygroups for
the ears, around the eyes, eylids, nose and jaw. Once we're
done with the polygroups, we can use the UV Master plugin to
generate clean UVs for the model. For this particular tutorial,
perfect UVs are not essential, but they let us transfer polypaint
data to texture and save them as images.

‘I Quickly texture Now that we have UVs, we can add
some colour to the wolf. The wolf in this tutorial will be a
dark brown/black wolf, but painting the underlying geometry
with more tones will make it look more interesting. We'll cover
everything with fur, so the texturing job doesn't have to be
precise. Import a few reference images from the Texture
palette and add them to Lightbox. Using the Standard brush
with only RGB enabled, roughly texture the model using your
reference photos that match different parts of the body.

Unwrap

Unwrap All

GroupVisible




Splitting versus

grouping

Splitting up your model could

be beneficial in many ways. Pl :
With multiple parts you can
achieve a higher level of detail e

and work faster since you can
turn the various parts on or .
off. Grouping is also very
helpful in order to create
selections and quickly hide
parts of your model. For the
purposes of this tutorial, we
don't need to split the wolf up
much as the details will be
defined by the fur, not in the
sculpted geometry itself.
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‘I Choose a pose Time to pose your model. Here is
where you can give character to your wolf and add
dynamism to your illustration. Wolves use a variety of complex
non-vocal communications to express submission or
dominance. To create tension, we'll put the wolf in a threatening
pose: teeth bared and lips curled, horizontal ears pointing
outwards. The straight tail and lower head posture could signify
hunting or intention to attack. To achieve all this, we can use
Transpose Master to move all the parts into place. The Move
Topological brush is also very helpful to fix tight areas.

14 Create fur We need to create the fur after the model
is posed, otherwise posing the wolf with fur would be an
incredibly difficult job. We'll create various groups of fur for the
various sections of the wolf depending on the length. However,
the process is the same for each part:
* Mask the area (and blur for smoother transitions).
* Preview FiberMesh, adjust if necessary and create fibres.
* Use the Move brush to move large areas into place.
* Use the Groom brushes to create the flow of the hairs.
» Use BPR to check progress, groom and move hairs further

if necessary.

‘I Create fur transitions Creating a natural transition

between the different lengths and sections of the wolf is
very important for a believable effect. The easiest way is to
create three sets of fur per section that require transitioning:
the short hair section, the long hair section, and the transition
hair that bleeds into the short and long sections. We can use
any of the grooming brushes to tweak and shape the fur. Since
we also have polygroups, you can turn the Mask By Polygroups
slider to 100 under the Auto Masking options of the brush to
affect them individually.

‘I Grow the fur We'll start with the head. With the head

selected, turn on solo mode to work faster. Use the
Masking brush to select the areas you want grow the fur
(avoiding eyelids and inner mouth). From the FiberMesh
palette, turn on ‘Preview’ and use the modifiers to tweak the
look of your fibres. The trick here is to keep the MaxFibers
slider low and compensate a bit with the Coverage slider. Use
the PBR button to test the FiberMesh and click on Accept once
you are happy with the result.

Posing and
asymmetry

A very distinctive way to
create realism is to have
asymmetry in your model.
If you have been sculpting
with symmetry enabled,
the posing stage is a great
opportunity to create
those subtleties. A great
deal of the asymmetry in
the wolf will be given by
the fur, because we will
create and groom the hair
with the wolf already
posed. Another chance to
create subtle asymmetry is
when texturing and
polypainting the model.



'I Groom the fur Select the GroomHairShort brush to

give direction to the hairs. It is a good idea to refer back
to the photos you've collected throughout your planning stage
to check the hair's natural flow. Remember that the fibres are
just polygons so you can use any of the sculpting brushes to
tweak them. The Move brush is particularly handy to readjust
the position of large areas of hair. Try to get the direction of the
hair in one stroke. Going over the same area multiple times
might twist the fibres and end up giving you some undesired
rendering effects.

‘I 8 Grow long hairs For the longer pieces of hair, we are

going to create a more blurred mask on the mesh. This
will help us with the transition from short to long fibres. You
can play with the ‘ByMask’ modifier slider if you want to tweak
the mask priority. Try to keep a low number in the ‘MaxFibers’
slider. The idea is that the sculpted chunks of hair will give us
the structure and direction of the fur and we'll only use
FiberMesh to cover the ‘spike’ of geometry to complete the
effect. If you find a few ‘bald’ spots after generating the fibres,
you can cover them later with transition hairs using a very soft
mask and low count of fibres.

1 Complete the final grooming and tweaks At this

point the hard work is almost finished. We can go over
the areas with longer hairs and use a custom version of the
GroomSpike brush in order to clump some hairs together.
Expand the Brush palette and under the Twist options, change
the Twist Rate and the Radius sliders to O. You can also reduce
the Z intensity a bit to have more control. With this custom
brush you can pull some long hairs together, especially around
the cheeks, neck and chest of the wolf. An additional trick is to
use the GroomTurbulence brush with a very low Z intensity
(say 5) and go over the entire model to give it a more natural
‘messy’ look.

2 Finish with BPR passes and compositing Once

you are happy with the wolf model (and the fur), you
can choose a camera angle to start the rendering process. The
most important step before you start your renders is to set the
document size and save your camera angle (from Document>
Zapplink properties). You can render as many passes as you
need for the compositing but there are a few which are
essential: a Colour or beauty pass, a Shadow pass, ZDepth,
Alpha and any light passes. Other passes such as AO might be
helpful but they're not essential. Save the BPR passes as PSD
files from the BPR Renderpass palette and drop them into
Photoshop as individual layers. For this illustration a ground
plane was quickly sculpted and added before rendering to
make the compositing a bit easier. The background is a series
of painted layers, blurred at different values to simulate the
depth of field.

Painting fibres from texture

You can colour the FiberMesh based on the textures
used on the underlying geometry. All you need to do is
set the BColour to 1and the TColour to O under

Modifiers in the FiberMesh palette. After creating the
fibres, you can use the Masking by Fibers feature under
the Masking palette to manually paint just the tips of the
fibres and neutralise the colour variations.
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Lighta
cinematic
scenein
Unreal

Learn how to create and finalise a
cinematic look and feel to your
Unreal Engine 4 environments

ere we will discuss how to create mood and visual
H storytelling in UE4. Understanding how to craft a

visual style and story can help you to create intense
moods or to provoke a particular emotion from the viewer.

We will look at creating key visual story elements in the
scene to help establish lighting, history, time, place, wear,
damage and other characteristics. In order to make an
impact on viewers, visual artists need to be able to establish
a visual background story. Knowledge of the elements that
help craft this story is important for any visual artists
wanting to impact the viewer.

We will also examine the use of post-processing settings
in Unreal to achieve mood through colour and value. Using
Photoshop to process our image and establishing a lookup
table (LUT) will help to form the colour palette for our whole
scene, with a focus on custom shadow and highlight colours.
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CLINTON
CRUMPLER
Kingwash Laundromat,
2016

Software

Unreal Engine 4, Photoshop

Learn how to

« Look develop a scene

« Develop for games

= Light a scene well

* Post-process

= Edit photos

« Texture assets

* Perform colour correction
* Master cinematography

* Create environment art

Concept

This piece was inspired by a
collection of night-time
photographs of Nineties neon
signs, old city buildings, hotels
and gas stations, as well as a
colour composition consistent
with horror films from the late
Eighties and early Nineties.

DOWNLOADS

from filesilo.co.uk/3dartist

* Scene files
* Tutorial screenshots

O‘I Establish the camera's view When creating a
foundation for your mood and story, perspective is key
to getting the right viewpoint. Try to think about where and
how the viewer sees the scene. Are they right in the thick of
things, seeing the view in a first-person perspective, or are they
a distant viewer watching from the outside? Is the gameplay
third person or first person? You will need to understand their
perspective in order to create mood and ambience. It will also
help you to tailor your scene and decide on level of asset detail.

O Test multiple camera key shots Place a few

camera actors in your scene to establish a couple of
key shots. Find what you want to focus on and what areas you
want your viewer to see (or not see). Sometimes, alluding to
more information off-camera can establish a mystery to be
discovered and can provide much more visual interest and
depth to your composition. Looking at the same area with a
different perspective through the camera'’s view can provide
you with a radically better composition. You can take direct
view of a camera placed in the scene by Ctrl/right-clicking it
and selecting Pilot Camera.

O Change the aspect ratio and FOV When using

the camera settings, you will find that increasing your
aspect ratio to 2 or higher and lowering the default field of view
from 90 to a value between 50 and 80 will provide a more
realistic and cinematic look. This is different than what a player
will typically use in a gameplay mode, but it provides a less
distorted perspective of the environment for cutscenes and
portfolio work.

O Add life into the scene Real-time animation and

dynamic changes in your scene can also provide clues
about what's happening. Moving flags, flickering lights and
neons, and animated monitors, for example, can all sell
different ideas and themes. Using simple material tricks, such
as vertex offset and emissive changes, can often provide big
visual impact at a small cost.

Add in narrative clues

Consider diversifying the visuals in your scene to help tell
a story or give context. For example, currency and
technology can always help reveal the year and setting.
Using time and place gives viewers context as to why the
scene looks the way it does, what year it is and in what
country or location the scene is set. Signage or notes can
be a more definitive way of establishing setting, but
making use of more subtle context clues rewards the
viewer more for paying attention to details in the scene.
These types of visual easter eggs can engage the viewer
to look for more hidden meaning.




O Use varying material types Try varying the types

of surfaces in your scene. The newest games, using a
PBR workflow, utilise all bells and whistles to make their visuals
look good. Using various types of materials, such as metals,
plastics, wood, concrete, plaster, ceramic and others, can help
to sell the believability of the scene, illustrating the different
ways the light plays off each surface.

O Work with lighting before post-processing It

can sometimes be hard to wait until the end of your
design to begin working with post-processing in Unreal, but
delaying it will prevent it from muddling your final results. Work
with lighting first and then do test builds to make sure you have
a good composition and range of contrast values throughout
your scene before moving on. Post-processing should strictly
be the icing on the cake, not a device used to cover up a hastily
made environment.

O Establish a colour palette List out all the films or
other visual media you have seen that have a similar
context and feel to that which you want to create. Pull a frame
from a film or game that inspires you and use a basic Gaussian
Blur on the image in Photoshop until there are a few colours
remaining. Doing so provides a good framework for your colour
palette. You can then use this palette to establish everything in
the scene from the paint on the wall to the colour of the lighting.

Disable Auto Exposure

for ease of use

When setting up lights, it's a good idea to place a Post
Process Volume within the scene. With the Volume
selected, enabling Unbound in its details will allow it to
affect not only the Volume, but also the whole scene.
Then in the settings, turn both the Min and Max
Brightness of the Auto Exposure to 1. This setting
disables the feature and keeps the light from auto
adjusting against the brightness of the scene, and
provides you a more consistent view of your lighting.



The Pipeline / LIGHT A CINEMATIC SCENE IN UNREAL

62

O Define the space with lighting Lighting is
sometimes an underused tool for environment artists,
but it can be your biggest ally. Let the lighting help define the
space. Be sure to allow each light in your scene to breathe, with
enough space to see breaks or rests in high and low-contrast
values. Try testing with Lighting Only mode or Detail Lighting to
see the best results. Shape your assets and props with framing
lights to push the sense of 3D space. You can change to Detail
Lighting or Lighting Only under the View Modes options.

O Establish visual priority \When placing lights, use

the overall lighting value to define importance within
any given shot. Using a range from brightest to weakest to
establish visual priority or inverting light colours compared to
your overall scene will provide focus to the viewer. For instance,
if your scene is cool-coloured, try a warm light to draw more
attention. Then you can cool the less important lights to make
them blend into the environment more. Volumetric effects and
meshes around lights can also really draw attention from the
viewer to add heavier feeling to the lit areas.

1 Bake lighting with Lightmass Do not forget to

place and surround your scene with a Lightmass
volume. Doing so allows the light bake to compute properly for
all the assets and actors contained within the volume. Also,
when baking and building lighting for your scene, start with
lower-quality settings of preview. This view speeds lighting
production time and allows for quicker iterations and faster
results. For the best results, make sure to use production-
quality lighting at the end.

Lighting Info
Use Error Coloring
10w Lighting Stats
Re
Update Reflection Captures
lity

Precompute Static Visibility

'I Work with Stationary Lights Using lights to highlight il Recnetry

material attributes will breathe life into your scene. A :
baked lighting scene using only point lights can sometimes
begin to look flat once the scene is built and baked. Stationary
Lights include features from both static and dynamic lights that g
provide for interesting lighting options. Sometimes, when using Build LODs
a Stationary Light, you can create nice glints on surfaces and
materials that bounce light to provide more visual interest.
Another tactic is to face the light towards the camera at an
acute angle to provide a nice reflection from the camera's
perspective. Remember to tweak the Shadow Bias and Filter
Sharpen for good contact shadows.

Jild Geometry (Current Level)

Medium

Preview

Add in fog effects

Fog is a very easy tool to use,
and includes some really nice
features. Fog can even help lift
some of the darkest areas in
your scene into a more
readable state. Also, fog can
help provide a sense of depth
and distance between objects
within the environment. Adding
a bit of colour to the fog can
give clues to time of day and
overall atmosphere. Be careful
not to use too much fog, as it
can quickly flatten or remove
all the contrast you have
worked so hard to create!
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'I Check the scene's values Try to keep your scene’s

light and dark values from hitting the extremes. Avoid
pure black shadows or pure white lighting. This not only allows
more visibility in your scene, but also allows for more control
when altering contrast or colours during the post-processing
stages. Using the Post Process Volume in your scene, you can
simply reduce the Saturation to O, which allows you to easily
see all values across the environment.

‘I Add lights to taste While setting up lighting, for a

darker-style room like this one you may have areas of
your scene that are too dark to read. While contrast is nice, try
to keep most your lighting values balanced by adding fill lights
to suit your visual taste. If you keep them small and with a
softer falloff with their aim pointing from the direction of a light
source, generally the visual will hold up and the mind’s eye will
fill in the blanks that the light must be coming from one of the
main lights in the scene.

’I Work in small increments Once you begin working

with the Post Process Volume, remember to make small
changes at a time. Almost all of the controls in this Volume can
have a dramatic impact on the overall visual for your scene.
Take and save screenshots, and make notes of the changes
made to achieve the look throughout the process. Oftentimes,
you may realise that you have gone too far or prefer an earlier
look. Maintaining history on your various looks can make it
much easier to get back and also help you to understand the
settings for the next time you create a scene and use the Post
Process Volume.

'I Add scene colour options Some of the quickest

wins for Post Process Volumes are in the settings under
the Scene Color options. Scene Color Tint, Vignetting, Fringe,
and Grain can all make nice additions to the scene. Remember
to use these in moderation, as they can quickly overpower and
cheapen the look of your environment. | recommend a value of
no greater than 0.5 for the Fringe or the Vignette Intensity,
depending on the mood you are trying to achieve. This will add
just a touch of camera effects for a more cinematic look.

Intensity

€0

Keep post work non-destructive
While creating a LUT, it is easiest to take a simple
screenshot of your scene in Unreal and then drop this
image into Photoshop. Then use layer adjustments with
Curves, Levels and so on to keep your work non-
destructive. Doing so allows you to keep your edits
changeable at any time and enables you to simply drag
and drop these adjustment layers into other Photoshop
files with the Unreal LUT texture for finalisation, export
from Photoshop and import into Unreal.
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‘I Create and use a look up table (LUT) Look up tables are one of the most efficient
tools when working with post-processing. They can change the overall mood and look of

a scene quickly along with using Photoshop tools to do it. Using the default LUT from the Unreal Showcase
documentation, you can apply Levels, Curves, Filter, Contrast, Brightness and many other effects

in Photoshop to alter the colour values throughout your scene. This should be left until very last, Clinton Crumpler

as it will change the colours and values of your scene from final tweaks.

Clinton is currently is a senior environment artist at
The Coalition in Vancouver, having recently delivered
Gears Of War 4. His primary focus is environment art,
shader development and art direction. He has also
released multiple video tutorials, articles and books.

Saigon Office, 2014

UE4, Maya, Photoshop, Quixel, ZBrush

This scene was created to establish a mood and look from
the Vietnam War era. Colour tones and furniture design
helped to shape the story.

'I Camera depth of field When setting up depth of field for your camera, using the
newer ‘CircleDOF’ method can provide the most convincing and real-world camera.
When using this method, the two most important controls in the post-process settings are the

& 4 P postproce e 4 2014 UE4, Maya, Photoshop, Quixel, ZBrush
Aperture F-stop and the Focal Distance. The F-stop controls the amount of information entering A } .
) ) ] ) ) old Soviet-era bunker retro-fitted for current-day use.
the lens, while the focal distance controls how far your main point of focus is from the camera. This scene was created as a technical showcase of
Use Show>Visualize>Depth Of Field Layers to enable an Unreal view mode to pinpoint the exact cave construction.
distance of where you want to focus in the scene.
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Composite
Cycles render

passes in
fter Effects

Use Adobe's tool to correctly
composite in linear space and
achieve stunning still life renders

render engine passes and how to leverage

compositing them together in After Effects for more
flexibility in post-production. The guide takes you through
the basics of multi-pass compositing. Learn about the
benefits of working this way and gain an understanding of
why this workflow can save you time in the long run when
working on complex scenes.

T his tutorial is about understanding Blender Cycles
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MIDGE SINNAEVE
Still Life, 2017

Software
Blender, After Effects

Learn how to
« Use Cycles render passes
« Extract them in After Effects

« Composite them correctly in
linear space

* Tweak your render using the
passes

* Add post effects using the
passes

Concept

| created this scene to help you
gain an understanding of how
Blender Cycles's render passes
work by going through the
process of compositing them
together correctly in After
Effects. Learn about both the
advantages and limitations of
using render passes in your
post-production work.

DOWNLOADS

from filesilo.co.uk/3dartist

= Scene files
* Video tutorial
» Tutorial screenshots

O Analyse the scene Open up the provided C2AE-
START.blend file to have a look at its contents. We'll use
this scene as a jumping-off point to set up the Cycles passes
we'll be using in After Effects. A final render has also been
supplied to work with, so no rendering is required to complete
the training. Take a moment to get agcuainted with the Blender

scene to be able to follow along easier.
O Set up the passes In the Render Layers tab of the
Properties window, there is a Passes section with all of
the render passes Cycles is able to output. We'll start by
selecting all 12 of the passes found under the Diffuse, Glossy,
Transmission and Subsurface headings. Be sure to enable the
Emission and Environment checkboxes as well. These passes
contain all the information we need to re-create our image in

After Effects.
O Add any additional useful passes On the left of
the passes there are a number of extra ultility passes
that can be added to a render. The Combined pass is enabled
by default and is just the final render. Leave this pass in for later
reference in After Effects. The others serve as tools to be used
when you're compositing the render. For example, the Z pass
can be used to add camera depth of field interactively in AE. Be
sure to check the Z, Mist, Object Index, Material Index and AO

passes respectively.
O Object Index Some passes need additional setup in
the scene, as is the case with the Object and Material
Index passes. These serve as masks that can be used in
compositing to tweak individual objects or materials. Starting
with the Object Index, a unique number needs to be assigned
to each object that a separate mask is wanted for. Do this by
selecting an object and going to the Object tab, then changing
the Pass Index under the Relations section. By default, all
objects have an Index of O, so make sure to have a unique value
higher than O for each object that needs a mask. In this case
the candle at the rear has an Index of 1and the candle at the
front has an Index of 2.
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O Material Index After setting up the Object indexes,

it's time to do the same for the materials of the fruit in
the scene. Each piece of the three types of fruit comes in two
variants, so there are six materials total to set up masks for, as
well as one for the velvet cloth. Start by selecting one of the
lemons and going to the Material tab. In this example, MESH.
Lemon.A.00T1 is selected. Under the Settings heading there is a
Pass Index option, which will be changed to 1 for the first
material (Lemon.A). Do the the same for each fruit variation
and the piece of cloth and make sure to increase the Pass Index
to a unique number for each material.

O The Mist pass Other utility passes that need extra

parameters are the Mist and AO passes. The Mist
pass is generally used to add some atmosphere into the scene
during compositing and as such needs to be set up to define
the visible distance of the scene. The AO pass, on the other
hand, can be used to add extra shadow-like detail. Both of these
passes are set up in the World tab after enabling them. These
values will be dependent on the size of the scene and will be
different for every project. In this scene, setting the Mist to 1.0
and 2.0 and the AO to 0.025 produced the desirable effects.
There's no need to check the Ambient Occlusion checkbox for
it to be rendered to a separate pass.

O Ready to render Before hitting the Render button,
there’s one last thing to set up. In order to have all the
render passes available in the output file, it must be saved in
the OpenEXR MultiLayer format. This ensures all the render
passes are contained in one image file, so they can be extracted
in AE later. The Float (Half) option has everything that's needed
to store all of the information and doesn't take up as much
space as the Full option. This can be set up in the Render tab.

Think about reflections

Whenever any changes are made to colours of objects in

compositing, remember that anything reflecting said
object remains unaffected. This will sometimes limit how
extreme the adjustments to the image can be.
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O Set up After Effects To set up After Effects fora
linear workflow, click on the 8bpc button at the
bottom of the Project panel. Set the Depth to 32 bits, Working
Space to sSRGB and tick the Linearize Working Space check box.
Now all of the colours in the project will be displayed correctly

and it's time to start compositing.
O Import the render Import the C2AE-FINAL.exr file
by going to File >Import. Drag the imported image
onto the Composition button at the bottom of the Project
panel. After Effects will create a composition with the image in
it as a single layer. With the image selected, add the EXtractoR
effect to it from the Effects menu. Click on the channels and
select RenderLayer.Combined in the layer dropdown. Hit OK to
enable the final render to show up in the Composition view.
This layer can now be used as a reference when combining all
the diffirerent passes.

Project =

L
[2]caae-FnaL L]

1 Composite the first colour passes Start by

duplicating the reference layer three times, so they
already have the EXtractoR effect applied to them. Renaming
the reference layer keeps things clear. Starting at the top, select
the RenderLayer.Subsurface.Col layer in the EXtractoR effect
and set the blending mode to Multiply. Select RenderLayer.
Subsurface.Ind for the layer under it and set the blending mode
to Add. Finally, set RenderLayer.Subsurface.Dir for the third
layer, leaving the blending mode at Normal. With these three
selected, go to Layer>Pre-Compose to group them together in
a new composition called SUBSURFACE.

1 Composite the other colour passes Refer to the

Pass mixing chart to set up the Diffuse, Transmission and
Glossy passes the same way the Subsurface passes were
combined. Don't forget to group each set into a pre-comp with
the approriate name to keep things easily readable. The last
pass that needs to be composited on top of the pre-comps is
the Emission pass. Copy the reference layer one more time and
select the RenderLayer.Emit layer in the EXtractoR plugin.
Finally, add together this pass and the pre-comps below it to
re-create the reference image.
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‘I Object Index masking To use the masks in the

Object Index pass, select the Renderlayer.IndexOB.X
channel manually for the Red, Green and Blue channels in the
EXtractoR plugin settings. Next, set the White Point to the
highest Pass Index selected in Blender. In this case that's 2. To
extract the mask from the greyscale image, add a Colorama
Effect after the Extractor and finetune it to only have the back
candle selected. This can now be used as a Luma Matte for an
adjustment layer with a Hue/Saturation effect above the
SUBSURFACE group. Please refer to the video for an in-depth
explanation of this.

1 Material Index masking The same technique

described in the previous step can be applied to the
Material Index mask pass. Don't forget to set the EXtractoR
white point to 7 instead of 2, as there were 7 Material Pass
Indexes set in Blender. Note the limitation of using these mask
passes with the fruit, where the mask is limited to the parts of
the objects that are directly visible. The parts that are refracted
in the bowl aren't masked, as Cycles treats all objects as
opaque when creating the mask passes.

'I The Ambient Occlusion pass This pass can
provide extra detail in shadowed areas of the render.
Once again, select the correct render layer in the EXtractoR
plugin after duplicating the reference layer. When this layer is
set to Multiply the white areas of the AO pass dissappear and
only the dark areas of the pass will affect the final image.
Experiment with the opacity of this layer by hitting the T key
with it selected in the timeline and changing the Opacity value.
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‘I The Mist Pass Although this pass is mainly meant for

use in large-scale images to create a sense of haze in the
air, it's still interesting to experiment with its effect on the
scene. In the EXtractoR effect, the Red, Green and Blue
channels need to be set manually to the RenderLayer.Mist.Z to
get a usable image. Set the layer to Add and experiment with
the opacity by hitting the T key with the layer selected.

'I The Depth Pass To use this pass to create depth of

field, first set the EXtractoR Red, Green and Blue
channels to the RenderLayer.Depth.Z and add a HDR Highlight
Compression effect after it from the Utility section in the
Effects menu. Then, pre-compose the layer with Move All
Attibutes Into The New Composition selected with the name
DEPTH COMP. This layer can now be turned off and moved to
the bottom of the layer stack, as it doesn't need to be visible to
use. Add an Adjustment layer to the top with a Camera Lens
Blur effect. In the effect, select the newly created DEPTH
COMP as the Blur map. Experiment with the focal distance and
blur size parameters to tweak the result.

‘I Final thoughts While this compositing method takes

some time to set up in After Effects, it can reduce the
number of re-renders from Cycles if some adjustments need to
be made, although some limitations apply. For a more in-depth
explanation, be sure to have a look at the video version of the
tutorial where each step is explained in more detail.
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* Tutorial screenshots

hen making a game asset, we often have to
endure time-wasting details such as seams,
marks and so on. In this tutorial | want to provide

some suggestions on achieving better results without wasting
time. I'll also share some tips to fix technical issues that we
might encounter in our work. We will go through why
Painter’s baker gives you some features worth using and how
time-saving Painter can be with a non-destructive workflow.
I'll explain a technique to create good-looking oil marks on
your textures and we will discover a cheap and fast way to
weld metal pieces without using the support geometry. We
will get rid of those seams that appear as a result of the
texturing process. Finally, we will learn how to set up your
lights in order to get a sweet-looking render of your model in
Marmoset Toolbag. Needless to say, you can perform this
tutorial in any software you choose. However, | think Painter
helps you to work very quickly in a way that software like
MARI and Mudbox couldn't. Regarding the rendering step, all
the tips are applicable to any render engine either in real-time
or offline, as the principle is still the same, so feel free to use
what you prefer most. These techniques are the result of my
experience in the game industry, and it goes without saying
that there are a lot of ways to achieve the same results. |
would suggest finding which one you like the most.
O Bake high polys in Substance Painter Do you
explode your meshes in order to avoid baked Normal
maps intersecting each other? If you are going to use Painter or
Designer you don't need to do that anymore. Thanks to its
baker, you can bake mesh/elements by name. Just export your
high-poly with the suffix _high and your low-poly with _low. For
example, in your file gas_tank_low.fbx you have these meshes/
elements: tank_low and valve_low in the same way that in your
gas_tank_high.fbx you have tank_high and valve_high. In this
way, Painter or Designer will bake each mesh individually.
O Assign materials in a non-destructive way The
client or your supervisor will give you feedback all the
time, and for this reason it's very important to practice a
non-destructive workflow as much as you can so you can
easily and instantly change information. A golden rule to do
that is by trying to avoid painting directly on layers. When |
want to add information to my texture, | begin with a Fill layer,
then | add a black mask on it and last, | append a Paint layer,
which | will use to manually paint on. This approach allows you
to modify the properties of the Fill layer, such as base colour,
roughness, metallic, height and so on any time, without having
to repeat your drawings, since all the painted data is stored in
the mask. As you can see, I've stored all my information in the
masks only, and this way | can easily and quickly change all my
information such as each graffiti colour, the dirty height and the
oil roughness without losing my masks.

03 Create oil marks on your model Start by creating
a new Fill layer and try to match the colour and the
Roughness value with some references. Then apply a black
mask with a Paint layer and start to roughly paint some leaking
marks - don't bother if they are too clear. Now create a new
Paint layer in the mask and set the blending mode to Pass
Through. Now it's time for the Smudge tool. With the second
Paint layer selected, start to move your Smudge brush in the
direction of your leak, moving it up and down until you get what
you want. Adding a new oil layer and new leaks with slightly
different properties will improve the result, giving it more
variety. Don't forget to slightly tweak the layer opacity.
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O Weld the metal parts together The approach
you choose to weld two metal pieces depends on a
lot of things, but most importantly how closely you'll see it. If
you can get very close, |'d suggest using geometry support.
Otherwise, you can quickly and easily do it by creating a new
Fill layer, or just using a default Rust material, increase the
Height map, create a black mask and a Paint layer like we just
did for the oil marks. Select the Artistic 2 brush preset, adjust
the brush'’s properties, such as Spacing and Hardness, in order
to get a nicer result. Start painting on the edges where you
want your weld marks to be. If the Height information is too
strong, just tweak down the value on the layer's properties.

O Paint over the seams For various reasons in game
assets we don't have sewn UVs, so we face a lot of
problems with noticeable seams even if your Normal baked
bevels are accurate. However, we can skirt around the issue by
manually painting over all the seams. In order to do that, we
have different approaches. The method that appeals to me
most is the following: create a layer (not a Fill layer), set the
blending mode of every channel to Pass Through, then select
the Smudge tool and lightly draw on the edges where the
seams are visible. This way, you blend together the information
on all the channels simultaneously, making seams fade away.

O Real-time rendering with Marmoset The last
step, but not the least important, is making a render of
your assets. Since we are dealing with game assets I'd advise
choosing a real-time renderer. In my example, I've chosen
Marmoset Toolbag. The first thing you need to take care of is
lighting. Avoid using just HDR lighting and light your model
using three main lights: a rim light, which brings out the
silhouette; a key light, which gives depth to your render; and a
fill light to reveal all the details of your textures. At this point,
switch back on your HDR, which will improve your reflections.

N
W

Problems with Normal maps

or texel density?

Baking details and bevels from your high-poly model to
the Normal map applied to your low poly might be a
pain, and it's very common to face problems of
noticeable seams or deformation. Another big issue you
might experience is having a consistent texel density all
over your model. If you have any trouble with either of
these, check the tutorials that | made about baking the
perfect Normal map, and about understanding texel
density. Simply head to www.leonano.com and visit the
Tutorial section.
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Technique focus

Incredible 3D artists take behind their artwork

LIGHTING | always stick to reality to make lighting as simple as it can be
when working on arch-vis projects. Artificial sources were extremely
important in this scene - | studied the intensity of these lights before
selecting their shape, colour and position. Combined with the right
camera setting, every aspect of the image gets along smoothly together.

Mohammadreza Mohseni
mohseni.info

lam a CG artist with a masters in
architecture and over ten years'
experience in 3D rendering
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« Tutorial screenshots

Enhance your workflow
with KATANA

3Delight renderer, are key players when it comes to

lighting, shading, look development and rendering for
professional movie productions and top-notch commercials.
In this tutorial you will learn how to import widely used
alembic files - which are figuratively the root for professional
asset-based workflows - and how to set up a project to
render a final image.

During this journey you will discover how the Node Graph

- KATANA's core working area - must be used and how the
actual data flow is represented. The next major workflow you
will learn is for asset behaviour. To control the behaviour of
objects in a KATANA project, you must leave the Node Graph
and change the asset influence in different contexts through
the so-called Scene Graph editor, which can be seen as a file
explorer with hierarchies. The general concept underlying
both work areas and the interaction from Node Graph to
Scene Graph with dataflow will be easier after this tutorial.

T he Foundry's KATANA, in conjunction with the famous

O Start a basic scene setup At first we must create

the scene including the hero assets followed by a render
camera. Jump to the Node Graph and open the Node menu
through the Tab key on the keyboard - an alternative would be
to use the right mouse button. By typing the first letters of a

node it will jump to the respective place in the list. We need the
following nodes: Camera Create, Alembic In and a Merge node.
Both transforms will be used to place the hero asset in the
scene. We must expand all branches in the Scene Graph
window. Only expanded branches will be shown in the viewer
and monitor.

O Place the camera in position With a simple

shaded asset it is already possible to adjust the final
camera position. Just jump to the Viewer widget and look
through the camera to find a suitable-looking position. The
necessary function lies in the centre just below the Perspective
view. Unfortunately the output image is still square-shaped. In
order to change that, we must append a Render Settings node.
In the corresponding attributes, choose HD for the Resolution
and activate a function called Adjust Width To Match
Resolution. Now the image takes HD 1080p picture
information as the global output for rendering.

O Work on a proper render output Before the
render image can be seen in the viewer or in the
3Delight framebuffer, there must be at least two more nodes
appended. The first of these two necessary nodes is a
DISettings node followed by a Render node. The first is



responsible for choosing the Anti-aliasing Filter method. In this
case we must use Blackman-harris with a Filter Width of 3
pixels. In addition to this, it is necessary to say what kind of
framebuffer should be used. In this workshop we've stayed in
KATANA and haven't used 3Delight's framebuffer. We must
choose KATANA's monitor. The Render node enables
rendering in passes and on a farm.

O Let there be light Before we start working on the

materials themselves, it is time to create some basic
light sources for a better look in the preview renders. After the
Merge node we must append a so-called Gaffer Three node.
This node is highly optimised and can hold a large variety of
direct and indirect light sources at once. In there we must
create two area lights, one with a warm tint and the other with
a cooler light-blue tint. The warmer colour will be the main light,
which is sending light from the left-hand side, while the cooler
light comes from the back on the right-hand corner.

O Set up basic materials Now we've reached the

stage where it's time to work on the materials. There
are plenty of ways to create materials in KATANA. In this
workshop we've jumped back on the top of our network and
we've create four DIShadingNode objects followed by four
Network Material nodes, one for gold, crystal, red SSS and a
material for the desk. Feel free to create crystal-coloured
variations. The Network Material nodes will obey a material
supplier by giving them a so-called DI Surface Terminal, which
is nothing more than a connector to input the colour out from
the DIShadingNode objects.

O Assign the materials for adjustments The basic

materials are in place but still not assigned, and that
will be our next step. Directly after the Merge node we must
append four Material Assign nodes from the Node menu. Each
Material Assign node consists of two blocks. In the Material
Assign block we must take the corresponding material from the
Scene Graph and drag and drop it with the middle mouse
button into the Material Assign field. In the upper area we'll
want to keep it simple with a path function in the CEL field. In
this field goes the geometry that needs to have the material
assigned. Repeat this step for all materials.

O Tweak the materials Creating a Shading node

followed by a Terminal only gives us a material
template. Now it is time to create real materials. In order to do
this, we must go back to each individual DIShadingNode object.
In the Attributes we must set a Correct Node type. By using the
drop-down menu we are able to choose between predefined
Material Builder nodes, as well as Single Functions to build a
complete material. For the red velvet material of the crown we
could use a _3delightSkin material, which gives us the ability to
use subsurface scattering for a nice, premium velvet effect.
There is also a _3delightMetal preset followed by a master
material called _3delightMaterial.

O Render the final image For the framebuffer we're

using KATANA's monitor, which means all images will
appear over there and will be saved into the catalogue. To start
a render simply Ctrl/right-click on a node - preferably the
Render node - and choose a preview image or the Rendering To
Disc mode, which will save the image or sequence into the
specified folder that was set in the DISettings node.

Add Terminal

DishadingNod

Add Statements +
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PNY NVIDIA
QuadroP5000

A new 16nm microarchitecture and specification bump
delivers significantly better all-round performance

VIDIA's rollout of the Pascal
N microarchitecture to its professional

GPUs, once again through sole
manufacturing partner PNY, has begun with
new cards across the board, ranging from the
entry-level Quadro P400 right up to the
monstrous P6000. The P5000 sits right
underneath it as the second most-powerful
3D card in NVIDIA's lineup.

Pascal is NVIDIA's most significant GPU
architecture upgrade in years, as it finally
shrinks the 28nm process that was used in
previous generations, such as Maxwell and
Kepler, down to 16nm. A smaller processor
means more transistors can be fit into the
same space and (theoretically) a similar
power envelope, which translates to
significantly better performance.

The P5000 uses the same GP104 core as
the gaming-oriented GeForce GTX 1080,
albeit with various enhancements such as
certified drivers and error-correcting code
memory, which significantly adds to the cost.
It ups the memory capacity to 16GB of
GDDR5X (a new, high-bandwidth memory
standard), providing more room to work with
larger textures and datasets.

Its a dual-slot physical design, with a single
power connector, retaining the four
DisplayPort outputs of the M5000 and a
single DVI-D connector, while offering
significantly higher bandwidth for display
data thanks to support for the DisplayPort 1.4
standard, ensuring compatibility with the
forthcoming crop of 4K displays with refresh
rates around 60Hz, a feature that gamers are
likely to be falling over themselves for, in time.

Notably, the funky angular design and
efficient cooler of the GeForce GTX 1080 has
not been carried over to the Quadro cards,
which retain a more mundane appearance.

Compared with the M5000, the GP104
core clock has almost doubled to 1607 MHz,
but with a slower memory clock of 1251 MHz,
for 288 GB/sec of memory bandwidth.
Shader count has increased to 2,560. TDP
has jumped to 180w, above the 150w used in
Kepler and Maxwell cards. CUDA support is
now at 6.1. Total FP32 computing power is
pegged at 8.9 TFLOPs, a huge leap from 4.3
TFLOPs in the M5000.

Last month we covered Chillblast’s Fusion
Pascal, which paired the card with a 3GHz,

10-core Intel Core i7-6950x chip. This month,
retailer Escape Technology kindly sent us
another workstation equipped with a P5000,
an HP Z640, which has fast become the
system of choice in large-scale commercial
project rendering setups.

It's notable for a very different CPU
configuration: dual Xeon E5-2630 v4 chips
and 64GB of system memory, offering a
tasty total of 20 physical cores (40 with
hyper-threading), but at a mere 2.2 GHz base
clock frequency.

In some tests, these performance
differences give us some idea of how much
CPU clock frequency and core count affects a
modern workstation. In short, raw GPU
performance benefits more from faster clock
speeds than more cores, but not in every test.

ArionBench, a good indicator of raw CUDA
performance, without any reliance on CPU
speed at all, shows a significant gain over the
M5000, leaping up to 2,673 points.

OpenCL performance on the other hand,
which received a massive boost with
Maxwell, improves by a further 25 per cent
here, with 12,531 points and again, the result
was just about identical on both systems.

But with SPECviewperf, we saw some tests
fall behind on the Xeon-equipped HP 2640,
compared with the faster Core i7 chip. Catia
was 30 points slower, Creo 25 points slower.
It confirms our view that the Core i7-6950x is
a better recommendation as an all-purpose
CPU choice for artists, unless of course they
work entirely with rendering tools that
maximise their CPU cores.

Comparatively, we tested the M5000 in a
workstation with an even faster 4 GHz 8-core
Core i7 5960x, which leaves the GPU more
headroom for performance, but skewing our
results in a direct comparison. In some cases
the P5000 in the 2.2GHz HP Z640 was only
slightly faster than the M5000 in a 4GHz
workstation, but it clearly storms ahead when
paired with the faster CPU in Chillblast's rig.

That illustrates our point further. The
P5000 is superb, and in many cases delivers
massively improved performance over the
M5000. But if you're considering such a
significant investment in graphics hardware,
you have to pay attention to how up-to-date
the rest of your computer is, too.

Orestis Bastounis

IRAY PERFORMANCE

Quadro cards have supported GPU-based rendering
through NVIDIA's Iray plugin for some time. But as of 3ds
Max 2017 you can use your GPU for a significant
performance improvement over CPU-based rendering, with
NVIDIA's new mental ray 3.14 renderer as well, thanks to its
new Gl engine called GI Next. Offering full support for
mental ray shaders, NVIDIA touts GI Next as 2-4x faster
than Final Gather Force, so you should expect much better
performance from the new renderer without having to make
significant changes to your workflow. NVIDIA's MDL
format for physical materials, which is cross compatible with
Iray, supports all traditional mental ray Effects. Ambient
Occlusion Pass is now also computed on the GPU as well.
According to NVIDIA's chart the P5000 performs 50 per
cent faster in mental ray over the M5000, in terms relative
performance against CPU-only rendering.
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LEFT The Pascal-based Quadros have a
more mundane appearance than the
GeForce GTX1080

MAIN 16GB of GDDR5X offers a
significant boost to memory performance

BELOW Our testing has really
demonstrated the need for a fast CPU to
make the most of the PSO00

BOTTOM CUDA performance, and
therefore corresponding render times
using mental ray and Iray, is the biggest
leap forward this generation

STEREO

Essentialinfo
Price

Website

VRAM

Bandwidth

Clock speed

Shader count

Performance

Summary

% % % % X Features
% % % % 7t Performance
% % % % ¢ Design

% % % % ¢ Value for money

£1950
WWW.pNy.com
16GB GDDR5X
288 GB/sec
1,607 MHz
2,560

89 TFLOPs

Verdict % % % %

The P5000 packs some high-end hardware for
significant performance gains in CUDA applications
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HDR Light Studio 5.4

The latest HDRLS release ushers in new features, light sources,

84

connection updates and improves usability

eveloped by UK-based company Lightmap,
D HDR Light Studio is a complete lighting

solution aimed at professional artists and
has an impressive customer base including many
world-class studios, boutiques and instantly
recognisable brands.

The Advanced Rotations feature, new in v5.4,
lets you quickly customise existing HDRIs by
adding image-based and procedural lights with
greater control. Previously, after you drag-and-
dropped lighting from the Presets pane onto the
Canvas containing your HDRI, placements were
hindered to being constrained to the centre of the
sphere mapped with a HDRI. Instead, you now
have the freedom to work with XYZ
transformations in World Space and via four
Rotation modes (Free, V-Lock, H-Lock and Fixed)
located in the Light Properties, Transform
(Extended) rollout under Enable Advanced
Rotations. V-Lock restricts movements to vertical,
H-Lock to horizontal and Fixed positions a light
horizontally aligned to the world X axis (looking
down from above). XYZ rotations are applied as an
offset to the Rotation Mode. This makes authoring
custom HDRIs incredibly artist-friendly, and using
the presets you can incorporate windows, decals
and logos, augment lighting and more. Adding
customisations takes mere minutes.

Thankfully, this toolset isn't just restricted to
HDRI work. When lighting 3D assets, for example,
Area lights can also be controlled using the
Rotation modes, which unlocks the ability to point
Area Lights in any direction. Further control has
been added for placing lights by enabling the
repositioning of their Light Handle (which act as a
pivot point). The Light Handle is displayed as a
small orange dot that by default is central in the
Light Preview pane and can now be dragged
around or repositioned using sliders. This makes it
easier to transform a light by its edge, which is
ideal for placing lights or imagery that needs its
edge on the ground plane, for example.

On top of that, 32 new light sources have been
added as a separate download to accompany the
release and this expands on the existing library of
presets. The presets accurately mimic studio
lighting and serve as an antidote to the often bland
lights offered by 3D apps out of the box. However,
options to rename presets and to search by name
would increase usability as opposed to manually
scrolling through the range available. Some
categories are rather limited with assets and
there's no workflow for artists to add their own to
the library at present.

If you trying the 15-day demo, the new presets
are still available to use, but the trade-off is that
they're low resolution. A couple of interface
updates let the cursor display the active tool in the
Canvas, Render View and Light Preview panes and
you can now double-click a slider's parameter
name to reset to its default value.

As a standalone product, HDRLS does fit neatly
into your pipeline. Load in your textured asset and
camera, set up lighting and export for final
rendering. Or you could alternatively use HDRLS
exclusively to customise HDRIs. Connections with
a number of industry-standard applications for
your pipeline setup are available at an additional
fee. We used it in conjunction with Maya 2017 and
Arnold, although the option to render with V-Ray,
mental ray, Maxwell, Octane, RenderMan and Iray
plug-ins is included with the Maya connection fee.
Connections grant artists the ability to see results
almost instantly with interactive rendering in their
3D app and provide the freedom to move the
lighting setup between apps and renderers if
needed which is a massive timesaver.

Coinciding with the new release are connection
updates for 3ds Max 2017 including ART Renderer
and Arnold, Cinema 4D R18 and DeltaGen 2017x.
Lighting scenes in HDRLS and seeing the results
update right away in Arnold efficiently bypasses a
lot of trial and error in your workflow.

Paul Champion

66 The presets accurately
mimic studio lighting and
serve as an antidote to the
often bland lights offered

by 3D apps 99
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MAIN HDRLS provides a fast solution for creating
your own HDRI maps to studio light your product

BOTTOM LEFT Being able to edit Light Handles
gives you greater control over light source
placement and makes fine-tuning notably easier

BOTTOM MIDDLE The well-presented and
intuitive Ul means you won't be needlessly
fumbling around for tools and settings while
trying to meet a tight deadline

BELOW The Presets library of light sources
contains many 4K HDR photos of real studio
lights designed to bring realism to your renders

O0O®©
(1l . O O

el

Essentialinfo

Price From £295
Website www.lightmap.co.uk
(O] Windows 7 and above, Mac OS10.7 and
above, Linux Fedora 13 and above

CPU 4 cores minimum
RAM 8GB minimum
Graphics Card Any, HDR Light Studio is CPU based
HDD Requires 6.5GB for a full installation with
Preset Lights

Summary

% % % % /¢ Features

% % % % % Performance
% % % % ¢ Design

% % % % X Value for money

Verdict % % % % ¥

Already a very competent and artist-friendly lighting
solution, HDRLS now features advanced tools to
improve usability
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Learn from the best in the
business with ZBrushLIVE

Media portal launched with live Twitch broadcasts featuring triple-A artists and industry pros,
the ZBrush Podcast, ZBrush news and much more

88

its annual ZBrushSummit events, Pixologic has
launched ZBrushLIVE, a one-stop shop for watching
and listening to ZBrush-themed videos and podcasts.

Launched on 6 February 2017, ZBrushLIVE has a regular
schedule of live Twitch broadcasts featuring artists from the
industry presenting content that includes character creation,
product design, 3D printing and more.

“Pixologic has been dedicated to building a thriving
artistic community from the very beginning,” says Michael
Nisbet, social media coordinator at Pixologic. “The artists
and professionals we have gotten to
know over the years have become like
family and we strive to keep that family
connected, growing and always
supplied with information and
resources to promote growth as not
only artists, but as an increasingly
social and educational group of friends
and collaborators.”

ZBrushSummit live streams have
previously featured sculpt-offs between
some of the best artists in the industry

N ot content with only broadcasting live streams during

66 2017 will feature
more of the hottest new
games and the artists
behind them who will
be able to answer
guestions and interact
with fans live yg

Michael Nisbet,
Pixologic

as well as ZPlays, which debuted at the Summit in 2016.
ZPlays will be one of the additions to the portal. “In addition
to live sculpting and design, one of our most exciting new
endeavours are our ZPlays,” says Nisbet. “These segments
feature the Pixologic staff playing recent titles along with
artists from the studio sharing behind-the-scenes info,
including the assets used to create the in-game models live
on Twitch... Each episode has been incredibly fun and full of
fascinating information behind some great games. 2017 will
feature more of the hottest new games and the artists
behind them who will be able to answer questions and
interact with fans live as we get our first
look at the new titles for this year.”
These exclusive hour-long live
gaming sessions feature the artists'
commentary, along with career
trajectory of the artists, Q&A from
viewers, modelling tips, workflow
discussion, shared assets and
behind-the-scenes insight on the game
being played. Previous episodes include
sessions on Fallout 4 with Bethesda
character artists Dennis Mejillones and



Lucas Hardi; Doom with id Software character artists Bryan
Woynia, Denzil O'Neill, Jason Martin and Emanuel Palalic;
and Final Fantasy XV with previous workflow content from
the Kingsglaive Square Enix ZBrushSummit presentation by
character and monster modelling supervisor Yuichi ltoyama
and CG designer Mitsunobu Ochi.

“The annual ZBrushSummit has been a testament to the
strength of this community and we're humbled each year to
meet people from around the world who are eager to learn
and meet other artists like themselves,” continues Nisbet. “It
keeps us striving to provide newer, increasingly engaging
content to accompany them along their journey and give
artists a community they can call their own.”

Also re-homed to ZBrushLIVE is the ZBrush Podcast,
which is a recorded, downloadable casual conversation
between Pixologic and top artists in film, games and more.
Concept artist Justin Goby Fields, Pixo Studio and lead
creature modellers (Kris Costa, Sunny Wei and Patrick
Gagne) from ILM have all already featured on the Podcast.
Audio from the ZPlays is also available in podcast form.

“ZBrushLIVE marks the next step in expanding our artist
family,” concludes Nisbet. “Our new Twitch channel and The
ZBrush Podcast are aimed to be more social and interactive
in a way that is fun and allows the community to get to know
professionals and network with other users.”

Get in touch... www.3dartistonline.com

Y @3DArtist

com/3DArtistMagazine
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Unity adds Octane

The integration of Octane will go “beyond texture maps"

Originally announced at Unite 2016, OTQY revealed
that OctaneRender and the ORBX file format would
be integrated into the Unity game engine for free
sometime in 2017.

CEO and OTQY founder Jules Urbach has since
announced more details of the integration. Speaking
to UploadVR, Urbach said that users will be able to
“take ORBX scenes from a plugin Octane supports...
bring them into Unity and rather than rendering

No-bake recipes

Jules Urbach, chief executive officer of
OTOY, says that the newly integrated
features in Unity will go beyond lightmap
baking. A real-time dynamic pathtracer will
be added to Octane 4, he explains. “This
really is the future of rendering - with
pathtracing, you're able to leverage an
unlimited number of instances.”

HAVE YOU HEARD

The Octane
integration was first
announced at Unity's
Unite 2016 event

them as a cinematic output asset, you can turn
them into a mesh, ingest them into the Unity scene
graph and use Octane to bake lightmaps, light
probes, all of it.”

“The future of baking has to go beyond texture
maps,” says Urbach, “and that's one of the reasons
we've introduced, officially... lightfield baking.”

Lightfield baking will take any bounding volume,
pre-process it on the cloud and create a
holographic volume. “This object is like a texture
map, it can be decoded at 1,000 frames a second
and within that volume you have perfect 60
degrees of freedom,” he continues to explain. “It's
amazing for replacement of mesh-based baked
lighting, and more importantly it can also encode
relighting information.”

Speaking of the game-changing lightfield baking
feature, Urbach states, “These things are really the
components for taking real-time game engine
content to the next level and Octane's going to
provide the pathway towards that.”

Chaos Group
co-founder
wins Oscar

Vlado Koylazov received
Scientific and Engineering
Award for creating V-Ray

The 2017 Academy Awards has given a
sci-tech Oscar to Chaos Group's Vlado
Koylazov for the “original concept,
design and implementation” of V-Ray.

“This award reflects the hard work
and dedication of the entire V-Ray
team,” said Koylazov, chief technical
officer and co-founder of Chaos Group.
“l am also immensely thankful to all the
artists and studios for the great work
they have created with V-Ray over the
years. | would like to congratulate the
other Sci-Tech winners as well - their
efforts have pushed the boundaries of
visual effects in film. We are looking
forward to more great movies in the
years to come.”

Other winners of the sci-tech
Awards include Marcos Fajardo for
Arnold; Larry Gritz for the Open
Shading Language; Kiran Bhat, Michael
Koperwas, Brian Cantwell and Paige
Warner for the ILM facial
performance-capture solving system;
Nicholas Apostoloff and Geoff Wedig
for the design and development of
animation rig-based facial
performance-capture systems at
ImageMovers Digital and Digital
Domain; Carl Ludwig, Eugene
Troubetzkoy and Maurice van Swaaij
for the CGlI Studio renderer at Blue Sky
Studios, and more.

V-Ray, created by Vlado Koylazov, has been
used on over 150 feature films since 2002

uillermo Del Toro's animated series, Trollhunters, is now available to watch on Netflix!




$500,000 up for

grabs for new
games idea

Epic Games and Wellcome have
organised a new competition for
European dev studios

If $5 million wasn't enough to hand out as part of its

Unreal Dev Grants, Epic Games has launched an entirely

new way for devs in Europe to win from a pool of a
whopping $500,000.
Working in collaboration with Wellcome, the

competition will see hopeful developers submitting new

game ideas based on the theme ‘transformations'’.

Six semi-finalists will then be chosen and given
$15,000 each to get them started on their projects.
Then the next round will see just three of the six
semi-final teams chosen, with $60,000 given out to
help with their game development.

The winning game will be announced on 24 January

2018, with the winner receiving $150,000.

Rocket 3F v1.0

The new polygon modeller aims to
be fast, friendly and fun for
everyone who utilises it

Rocket 3F, created by concept artist Andrei
Samardac and programmer Kun Shi, is a simple
polygonal modelling tool for capturing ideas and
translating them into the 3D space.

Rocket 3F has streamlined tools that allows you
to work very quickly with only a mouse - or stylus
- and without additional windows. Another tool
called Preview allows you to see the model at the
final stage without rendering. On top of that, Hard
Edge and Organic Edge enable the user to work
with different types of object, while the Creased
Edges function creates creases easily and can be
changed to hard or organic at any time.

To learn more about the software or to get your
own iteration, visit www.rocket3f.com.

Software shorts

iKinema LiveAction3
Version 3 of the mocap retargeting
tool for Unreal Engine features
automatic bone mapping and
support for custom mocap systems. You can also
stream real-time mocap data in real time for
viewing in UE4. Other features include Template
editor, custom name matching, skeleton matching
on target rig and an improved workflow for ACP.

DID YOU KNOW? Hugo Barra, a former vice president at Google, will now be vice president of VR at Oculus

Pixel Farm claims its new release
is “unrivalled"” by any other
similar app features

The 2017 version of PFTrack has been released
by Pixel Farm, which have said that it is the
“possibly our biggest upgrade since the
introduction of the highly-acclaimed node tree
in 201"

New features include the embedded
functionality of PFDepth nodes in PFTrack with
added methods for creating and manipulating
Depth maps. The stereo camera and image
pipeline has been extended, and so has the
digital photography camera support. The user
interface has been enhanced to provide better
productivity and there are now advanced
photogrammetry texture extraction tools.

For the full list of features, be sure to visit
www.thepixelfarm.co.uk.

The theme of
HENSIEI
based on the idea
of exploring the
human condition

PFTrack 2017 unleashed

— e

The Z-Depth Solver node has
been updated for PFTrack 2017

Bringing you the lowdown on product updates and launches

C4Dome 2.75

Popular HDR lighting plugin
C4Dome now supports Cinema 4D
R18 with express compositing in just
one click, easily adjustable HDRI tone mapping,
three kinds of floor system presets for reflections,
an HDRI painter for painting your own HDRI maps,
as well as the additional ability to save and load
lighting presets.

Polybrush 1.5

The 3D modelling editor now has an
updated interface. Bones is also now

ESESSN 2 mode instead of a tool for creating
precise forms, with a new Surface tool for creating
a surface between bones. The new Pipes tool also
replaces bones to smooth pipes with any section.
To learn more about Polybrush, head online to
www.polybrush.org.
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Studio MPC

Website moving-picture.com
Location Montreal, Canada
Project A Monster Calls
Project description A Monster

Calls stars Lewis MacDougall as
a12-year-old boy who befriends
amonster, voiced by celebrated
actor Liam Neeson

Company bio MPC has over 25
years of experience as one of
the top VFX studios in the
world for film and advertising.
With its headquarters in
London, UK, MPC also has
facilities in Canada, US, the
Netherlands, France, China and
India. MPC won an Academy
Award in 2012 for its visual
effects work on Life Of Pi.
Contributors
* Ferran Domenech,

VFX supervisor

A Monster
Calls

VFX supervisor Ferran Domenech
tells us how MPC built the ultimate
monster from the ground up

onor O'Malley is only 12 years old. Not only is he facing

bullies at school, but his mother has terminal cancer,

his grandmother is domineering and his father is
thousands of miles away. But then, a 40-foot-tall monster
arrives one night, towering over his bedroom window and
changing his life forever.

It's a deeply poignant film, not least with the monster's
design being one of the most fantastical and memorable
creations to appear on-screen in recent years. MPC's VFX
supervisor Ferran Domenech worked on A Monster Calls for
almost a year to deliver the vision of director J A Bayona, with
the rest of the team working from six to nine months.

Working in the MPC Montreal facility, Domenech led a
team to deliver around 180 shots for A Monster Calls, with the
work including close-up shots, transformation of the monster,
dialogue shots, modelling the full body and sharing assets
with other vendors on the project, such as El Ranchito and
Glassworks Barcelona.

At the start of production, the monster's facial rig went
through a concept phase for a couple of months with plenty
of research and development taking place to establish just
how MPC would add expression to it. “The monster was
made of wood, which is obviously a hard surface that should
not easily move,” explains Domenech of the challenges in
working with a talking facial rig. “We settled for a facial rig
made of many interlocking pieces that would slide against
each other without deforming. This was technically tricky to
do, since the setup had to work and avoid collisions between
the pieces, and it was also slow to animate when in full detail,
but it gave the best final look.”

For the transformation sequence, a yew tree is turned into
the monster. Just like the facial rig, the yew tree was built up
from broken pieces and Domenech explains why: “The yew
tree was big enough to fit the monster inside it and as he
stood up, he literally rips out of the canopy. As the pieces fall
to the floor, the monster is revealed.”

These shots would end up being the most testing for MPC,
requiring the work of every single department in order to
achieve the final result. The assets department would start
with special breakable models, moving on to complex rigs
from the rigging department, tricky choreographed animation
and technical animation to add leaves moving in the wind and
pieces falling from him, with many layers of FX dust, and
heavy and complicated lighting renders all finally put together
by senior compositing artists. “I would say that the
transformation shots were definitely the most time-
consuming shots to create and the most visually exciting,”
continues Domenech.

Beyond just the tree transformation, another, more angered
version of the monster was also created with protruding
bones and a flaming glow. “The ‘angry monster’, as we call it,
was a variation of the standard monster that had extra




The transformation
shots were definitely the
most time-consuming
shots to create and the

most visually exciting

Ferran Domenech,
VFX supervisor

01 The assets team at MPC adjusted the wooden
pieces to work for animation and augmented the
facial structure so that the mouth, eyebrows and
eyes could move

02 The performance capture production was a
creative collaboration between director J A Bayona
and Audiomotion, headed up by MD Brian Mitchell

03 The monster is a 40-foot yew tree voiced by actor
Liam Neeson, who spent two weeks with
Audiomotion to create the mo-cap work







Moving on
from mocap

VFX supervisor Ferran Domenech explains why
mocap couldn't be used for the close-up dialogue
shots of the monster

The animation team used video reference of Liam Neeson

to match lip sync, facial expressions and eye movements.
“With the difference in size and proportion between a
human and the monster, we found that using mocap was
not that practical, as we would have to keep making
adjustments for weight and also reposing to match the
space and what was directed on each scene. So we opted
for fully key frame body and facial performances.”

controls to expand the muscles and open his chest. It could
also change the shape of most of his facial wood pieces into
sharper, longer versions.”

The angry variation also had to enable the growth of
branches for his body, and the team had to add extra
branches where needed. “With all of these controls the
animators could change him from normal to angry and back
within a shot,” says Domenech.

Other wood pieces would be modelled and textured across
the whole body. The pieces would consist mostly of different
types of wood, with the head, hands and feet created first
using the on-set practical monster as reference. The rest of
the body would be built from scratch, based on 2D designs
and pictures of clay model references provided by the film's
production team.

Tangled with branches and vine, the monster was then
virtually brought to life with this wooden nervous and
musculature system. “To get the body to move in a logical
way, the muscle groups were designed roughly based on
human anatomy, including tendons and fibres that would
allow the arms and legs to move,” reveals Domenech. “This
was made of vines and greener pieces of wood that would
slide under the outer layer of hard bark.”

Other than the wooden texture muscle systems, another

core element in breathing life into the monster were its

human-like eyes, providing expressive cues throughout the

movie. These were essential in providing a window into the
04 An on-set practical version monster’s behaviour, all without losing its natural tree form.

of the monster would be

used for reference by MPC The moss that grows across the monster's body, for

example, was used as inspirations for the colour of the
05 The technical animation monster's eyes. “The eyes had to communicate emotion,”
department also . R
implemented wind Domenech begins, “and some of the practical monster
simulations for the small designs had very colourful and striking looks, but could also
branches on the monster . . .
be too distracting for a talking performance. So we were
asked to do a series of concept art designs with different
types of eyes. In the end the colour scheme chosen had to
complement the colours of the monster. The face is covered
in small patches of green and yellow moss, so this colour
range on the eyes was sympathetic to the design.”

With this deep, emotional connection built from just the
eyes and face alone, it comes as no surprise to learn that
these formed part of Domenech'’s favourite shots. “I enjoyed
the last shots in the film the most, where the eyes and the
subtle facial performance of the monster play an important
part in the story.”
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Images of
the month

These are the 3D projects
that have been awarded
‘Image of the week’ on
3DArtistOnline.com in the
last month

by Oskar Fiileki

3DA username
Visumetrie

Oskar Fiileki says: “| was
inspired for this project by a picture
of an old antique kitchen. My goals
were to create an atmospheric
lighting situation and give the
materials some realistic traces

of usage.”

Wessay: There's a really nice rustic feel
to Oskar’s kitchen render and we love
how it's illuminated by that one stream
of light coming in from the left-hand
side of the image, creating a sort of
early-morning atmosphere.

02 Elephant
s by Dmytro Teslenko

3DA username

Dmytro Teslenko

Dmytro Teslenko says:
“Hello, | wanted to show off a
project that I'm very proud of - an
elephant made in 3ds Max, ZBrush
and MARI. Post-processing was
done in Photoshop. | hope you
enjoy it!"
Wessay: It's amazing how artistic an
effect is achieved when you put
something from the natural world in a
studio environment. The thing that
makes this elephant look so real,
though, is probably Dmytro’s fantastic
sculpting work.

03 In the Cold,
Night

by Joaquin Kierbel

3DA username

£ jkierbel

Joaquin Kierbel says:

“A sci-fi 3D concept made in my

spare time. Mainly done in Blender,

with World Machine for the terrain

map and some Houdini for the

spiral-style mesh.”

We say: Abstract sci-fi renders are

always cool, and adding a human

figure being beamed up is a nice touch

that adds a sense of scale that would

otherwise be missing. The terrain at

the base of the structure is impressive.

04 Alchemy
Room

by Isai Ramirez Molina
3DA username

! Isai Ramirez

Isai Ramirez Molina says:

“For this work | found inspiration in
steampunk galleries. | modelled
everything based on a sketch | did
myself. In this project | used Corona
Renderer, and used Photoshop for
post-production.”

We say: The first thing we thought
was that this environment wouldn't
look out of place in a BioShock game,
which is high praise indeed! The
individual details are superb and the
unorthodox camera angle actually
adds a lot.

Share your work, view others' and chat to other artists, all on our website
Register with us today at www.3dartistonline.com




Steampunk Pig by Mary Fazzolari

3DA username Mary Shan

Mary Fazzolari says: “Steampunk has always fascinated me. One

. day | was sketching some ideas and | came up with this
WAL character. It was looking very cool so | decided to give it a try

with Blender.”
We say: Mary's character render is so delightfully bizarre that we had to include it
here. The cartoon proportions are spot on and we're big fans of his top hat and
moustache combo.

w Garden by Vic Nguyen

¥} D .
= J}' 3DA username VicnguyenDesign

VicNguyen says: “"Here is a project | did for an Evermotion

\ ‘Secret Garden’ challenge in 2016. | wanted to express a special
perspective that's perhaps a bit unusual.”

We say: Looking at things from a completely different perspective can be so

valuable if you're willing to experiment. That's exactly what Vic has done here,

resulting in a really unique arch-vis render that easily stands out.




Technique focus ~ LIGHTING

Peter Ang

dartofang.com

Peter is a senior 3D visualiser. His
work has been featured in Expose,
Exotique and 3D Artist magazine
Software 3ds Max, Corona,
Photoshop, After Effects, Frischluft

CakePlease,

2016 /

Technique focus

Incredible 3D artists take behind their artwork

LIGHTING After detailing the model | then proceeded to light and
texture using Corona Renderer. For the lighting | used one Corona light
rectangle for the window on the right, and another fill light on the left.
Always try to use photographs as reference for your lighting because it
will give you a sense of direction on what are you trying to achieve.
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»Perfect World“ by Katie Melua | Directed by Karni & Saul © Sulkybunny www.rebusfarm.net/sulkybunny

RebusfFarm

Render Service

Making your deadline in time was never easier, faster and safer than now. Unleash
the power of 5000 CPUs right into your desktop. If you are new to our online
render service feel free to use this coupon code 3DA-RF-LP104K to receive
35 Renderpoints worth 35€. Go to our website, register and enter your coupon code.
Download our advanced RebusFarm software and send some test frames to find out F R E E
yourself how fast and easy it works. The RebusFarm render service is processing 24/7.
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